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Preface

This manual is your primary source of introductory and reference information for 
Oracle9i for Windows 98 for both client and server. Differences between product 
versions are noted where appropriate.

This manual describes only the features of Oracle9i Personal Edition software that 
apply to Windows 98 operating system.

This preface contains these topics:

n Audience

n Documentation Accessibility

n Organization

n Related Documentation

n Conventions
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Audience
This manual is intended for:

n Database administrators

n Network administrators

n Security specialists

n Developers who use the Oracle9i database

To use this document, you need:

n Windows 98 installed and tested on your computer system

n Knowledge of object-relational database management concepts

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at

http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, JAWS may not always read a line of text that 
consists solely of a bracket or brace. 

Accessibility of Links to External Web Sites in Documentation This 
documentation may contain links to Web sites of other companies or organizations 
that Oracle Corporation does not own or control. Oracle Corporation neither 
evaluates nor makes any representations regarding the accessibility of these Web 
sites.
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Organization
This document contains:

Chapter 1, "Introduction"
Explains how different groups of users can use this document together with 
Oracle9i Database Administrator’s Guide for Windows and Oracle9i Network, 
Directory, and Security Guide for Windows. 

Chapter 2, "Oracle9i Differences between Windows 98, Windows NT, and 
UNIX"

Compares features of Oracle9i Database for Windows 98, Windows NT,  and 
UNIX. This information may be helpful to Oracle developers and database 
administrators moving from UNIX to Windows platforms. 

Chapter 3, "Oracle9i Architecture on Windows"
Describes how Oracle9i architecture takes advantage of some of the more 
advanced services in the Windows operating system.

Chapter 4, "Database Tools Overview"
Provides a list of preferred and optional tools you can use to perform common 
database administration tasks.

Chapter 5, "Multiple Oracle Homes and Optimal Flexible Architecture"
Describes how to use multiple Oracle homes and an Optimal Flexible 
Architecture (OFA) configuration for placement of database files.

Chapter 6, "Oracle9i Default Accounts and Passwords"
Describes usernames and passwords included in the starter Oracle9i Database.

Chapter 7, "Configuration Parameters and the Registry"
Describes the use of the registry for various Oracle components. In addition, 
this chapter lists the recommended values and ranges for configuration 
parameters.

Chapter 8, "Developing Applications for Windows"
Points to sources of information on developing applications for Windows and 
outlines a procedure for building and debugging external procedures.
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Appendix A, "Error Messages"
Lists the error messages, causes, and corrective actions that are specific to the 
operation of Oracle9i for Windows.

Appendix B, "Getting Started with Your Documentation"
Describes the contents of your Oracle documentation set.

Glossary

Related Documentation
This manual is part of a set for developers and database administrators using 
Oracle9i on Windows. The other manuals in the set are:

n Oracle9i Database Administrator’s Guide for Windows 

n Oracle9i Network, Directory, and Security Guide for Windows  

For information on the components available in your Oracle9i installation type, see 
your Oracle9i Personal Edition Installation Guide for Windows 98. 

For Oracle product information that is applicable to all operating systems, see your 
Oracle9i Online Documentation Library CD-ROM for Windows. Many of the 
examples in the documentation set use the sample schemas of the seed database, 
which is installed by default when you install Oracle. Refer to Oracle9i Sample 
Schemas for information on how these schemas were created and how you can use 
them yourself.

If you are not familiar with object-relational database management concepts, see 
Oracle9i Database Concepts. 

In North America, printed documentation is available for sale in the Oracle Store at

http://oraclestore.oracle.com/

Customers in Europe, the Middle East, and Africa (EMEA) can purchase 
documentation from

http://www.oraclebookshop.com/bookshop.html

Other customers can contact their Oracle representative to purchase printed 
documentation.

To download free release notes, installation documentation, white papers, or other 
collateral, please visit the Oracle Technology Network (OTN) at
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http://otn.oracle.com 

You must register online before using OTN; registration is free and can be done at

http://technet.oracle.com/admin/account/membership.html

If you already have a username and password for OTN, then you can go directly to 
the documentation section of the OTN Web site at

http://technet.oracle.com/docs/index.htm

Conventions
This section describes the conventions used in the text and code examples of this 
documentation set. It describes:

n Conventions in Text

n Conventions in Code Examples

n Conventions for Windows Operating Systems
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Conventions in Text
We use various conventions in text to help you more quickly identify special terms. 
The following table describes those conventions and provides examples of their use.

Convention Meaning Example

Bold Bold typeface indicates terms that are 
defined in the text or terms that appear in 
a glossary, or both.

When you specify this clause, you create an 
index-organized table. 

Italics Italic typeface indicates book titles or 
emphasis.

Oracle9i Database Concepts

Ensure that the recovery catalog and target 
database do not reside on the same disk.

UPPERCASE 
monospace 
(fixed-width 
font)

Uppercase monospace typeface indicates 
elements supplied by the system. Such 
elements include parameters, privileges, 
datatypes, RMAN keywords, SQL 
keywords, SQL*Plus or utility commands, 
packages and methods, as well as 
system-supplied column names, database 
objects and structures, usernames, and 
roles.

You can specify this clause only for a NUMBER 
column.

You can back up the database by using the 
BACKUP command.

Query the TABLE_NAME column in the USER_
TABLES data dictionary view.

Use the DBMS_STATS.GENERATE_STATS 
procedure.

lowercase 
monospace 
(fixed-width 
font)

Lowercase monospace typeface indicates 
executables, filenames, directory names, 
and sample user-supplied elements. Such 
elements include computer and database 
names, net service names, and connect 
identifiers, as well as user-supplied 
database objects and structures, column 
names, packages and classes, usernames 
and roles, program units, and parameter 
values.

Note: Some programmatic elements use a 
mixture of UPPERCASE and lowercase. 
Enter these elements as shown.

Enter sqlplus to open SQL*Plus.

The password is specified in the orapwd file.

Back up the datafiles and control files in the 
/disk1/oracle/dbs directory.

The department_id, department_name, 
and location_id columns are in the 
hr.departments table.

Set the QUERY_REWRITE_ENABLED 
initialization parameter to true.

Connect as oe user.

The JRepUtil class implements these 
methods.

lowercase 
monospace 
(fixed-width 
font) italic

Lowercase monospace italic font 
represents placeholders or variables.

You can specify the parallel_clause.

Run Uold_release.SQL where old_
release refers to the release you installed 
prior to upgrading.
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Conventions in Code Examples
Code examples illustrate SQL, PL/SQL, SQL*Plus, or other command-line 
statements. They are displayed in a monospace (fixed-width) font and separated 
from normal text as shown in this example:

SELECT username FROM dba_users WHERE username = ’MIGRATE’;

The following table describes typographic conventions used in code examples and 
provides examples of their use.

Convention Meaning Example

[ ] Brackets enclose one or more optional 
items. Do not enter the brackets.

DECIMAL (digits [ , precision ])

{ } Braces enclose two or more items, one of 
which is required. Do not enter the braces.

{ENABLE | DISABLE}

| A vertical bar represents a choice of two 
or more options within brackets or braces. 
Enter one of the options. Do not enter the 
vertical bar.

{ENABLE | DISABLE}

[COMPRESS | NOCOMPRESS]

... Horizontal ellipsis points indicate either:

n That we have omitted parts of the 
code that are not directly related to 
the example

n That you can repeat a portion of the 
code

CREATE TABLE ... AS subquery;

SELECT col1, col2, ... , coln FROM 
employees;

 .
 .
 .

Vertical ellipsis points indicate that we 
have omitted several lines of code not 
directly related to the example.

Other notation You must enter symbols other than 
brackets, braces, vertical bars, and ellipsis 
points as shown.

   acctbal NUMBER(11,2);

   acct    CONSTANT NUMBER(4) := 3;

Italics Italicized text indicates placeholders or 
variables for which you must supply 
particular values.

CONNECT SYSTEM/system_password

DB_NAME = database_name
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Conventions for Windows Operating Systems 
The following table describes conventions for Windows operating systems and 
provides examples of their use.

UPPERCASE Uppercase typeface indicates elements 
supplied by the system. We show these 
terms in uppercase in order to distinguish 
them from terms you define. Unless terms 
appear in brackets, enter them in the 
order and with the spelling shown. 
However, because these terms are not 
case sensitive, you can enter them in 
lowercase.

SELECT last_name, employee_id FROM 
employees;

SELECT * FROM USER_TABLES;

DROP TABLE hr.employees;

lowercase Lowercase typeface indicates 
programmatic elements that you supply. 
For example, lowercase indicates names 
of tables, columns, or files.

Note: Some programmatic elements use a 
mixture of UPPERCASE and lowercase. 
Enter these elements as shown.

SELECT last_name, employee_id FROM 
employees;

sqlplus hr/hr

CREATE USER mjones IDENTIFIED BY ty3MU9;

Convention Meaning Example

Choose Start > How to start a program. For example, to 
start Oracle Database Configuration 
Assistant, you must click the Start button 
on the taskbar and then choose Programs 
> Oracle - HOME_NAME > Configuration 
and Migration Tools > Database 
Configuration Assistant. 

Choose Start > Programs > Oracle - HOME_
NAME > Configuration and Migration Tools > 
Database Configuration Assistant

File and Directory 
Names

File and directory names are not case 
sensitive. The special characters <, >, :, ", 
/, |, and - are not allowed. The special 
character \ is treated as an element 
separator, even when it appears in quotes. 
If the file name begins with \\, Windows 
assumes it uses the Universal Naming 
Convention.

C:\winnt"\"system32 is the same as 
C:\WINNT\SYSTEM32

Convention Meaning Example
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C:\> Represents the Windows command 
prompt of the current hard disk drive. 
The escape character in a command 
prompt is "^". Your prompt reflects the 
subdirectory in which you are working. 
Referred to as the command prompt in 
this manual.

C:\oracle\oradata>

The backslash special character (\) is 
sometimes required as an escape 
character for the double quote (") special 
character at the Windows command 
prompt. Parentheses and the single quote 
special character (’) do not require an 
escape character. See your Windows 
operating system documentation for more 
information on escape and special 
characters.

C:\>exp scott/tiger TABLES=emp 
QUERY=\"WHERE job=’SALESMAN’ and 
sal<1600\"

C:\>imp SYSTEM/ password 
FROMUSER=scott TABLES=(emp, dept)

HOME_NAME Represents the Oracle home name.

The home name can be up to 16 
alphanumeric characters. The only special 
character allowed in the home name is the 
underscore. 

C:\> net start Oracle HOME_
NAMETNSListener

Convention Meaning Example
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ORACLE_HOME 
and ORACLE_
BASE

In releases prior to Oracle8i release 8.1.3, 
when you installed Oracle components, 
all subdirectories were located under a 
top level ORACLE_HOME directory that by 
default was:

n C:\orawin95 for Windows 95
n C:\orawin98 for Windows 98

or whatever you called your Oracle home.

This release complies with Optimal 
Flexible Architecture (OFA) guidelines. 
All subdirectories are not under a top 
level ORACLE_HOME directory. There is a 
top level directory called ORACLE_BASE 
that by default is C:\oracle. If you 
install Oracle9i Release 1 (9.0.1.1.0) on a 
computer with no other Oracle software 
installed, the default setting for the first 
Oracle home directory is 
C:\oracle\ora90. The Oracle home 
directory is located directly under 
ORACLE_BASE.

All directory path examples in this 
manual follow OFA conventions.

See Chapter 5, "Multiple Oracle Homes and 
Optimal Flexible Architecture" for 
additional information on OFA 
compliance and for information on 
installing Oracle products in non-OFA 
compliant directories.

Go to the ORACLE_BASE\ORACLE_
HOME\rdbms\admin directory.

Convention Meaning Example
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Introduction

This chapter briefly describes the Oracle9i for Windows documentation set and 
shows how the three books in the set relate to common database administration 
tasks.

This chapter contains these topics:

n Document Plan

n Task Mapping
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Document Plan
The documentation for Oracle9i for Windows is divided into three parts.  This 
manual contains information with the widest possible relevance. Whatever your 
database management role, you will probably find something of interest here. The 
other two manuals concentrate on tasks usually associated with the different realms 
of management required by a large database with many users. The three manuals 
are titled:

n Oracle9i Personal Edition Getting Started for Windows

n Oracle9i Personal Edition Database Administrator’s Guide for Windows

Task Mapping
We recognize that this division cannot be perfect for everyone. What one 
organization calls database administration, another will call a network problem; 
and only parts of this manual or its companions are relevant to particular tasks. So 
in this first chapter we provide a table that maps specific tasks to specific chapters 
and appendixes in the three manuals. 

Table 1–1 lists common database tasks, grouped into three categories:

n Application Development

n Database Administration

n Network and Security

For each task, the columns labeled Getting Started, Administrator, and 
Network/Security show the chapters and appendixes in each of the three manuals 
which contain information relevant to that task.
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Table 1–1 Where to Find Task Information

Task Category Getting Started Administrator

Database Administration

Back Up and Recover 2, 3, 4, 7 5

Create or Delete Database 4 1

Create Objects 4  

Export, Import, or Load Data 4 1

Find Files (Directory Structure) 2, 3, 4, 5, 7 1, 2

Install or Configure 2, 4, 5, 7 1,2,,6

Manage Processes 2,3,4,5,7,A 4

Manage Resources 2,,4,5,A 3,6

Manage Services 2,,4,5,A 1, 3

Migrate or Upgrade 4,5

Monitor Performance 2,3,4,7,A 4

Startup or Shutdown 2,4,7,A 1, 3

Network and Security

Accounts and Groups 2,4,7

Authenticate Users 2,4,7

Connectivity Information 3,4,5,7,8,A 3

Create Users 2,4

Application Development

Application Programmatic Interfaces 3,4,8 

External Procedures 8

Microsoft Transaction Server 2,3,8  

Oracle Real Application Clusters 2, 7
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Oracle9i Differences between Windows 98,
Windows NT, and UNIX

The following table lists the major differences among Oracle9i Personal Edition for 
Windows 98, Oracle9i on Windows NT, and on UNIX. For Oracle database 
administrators moving from a UNIX platform to Windows 98/NT, this information 
may be helpful in understanding the Windows 98/NT features that are relevant to 
Oracle. 
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Feature On UNIX... On Windows 98/NT...

Services/Database instance UNIX daemons are similar to 
services on Windows NT.

On Windows 98:

There is no service available on 
Windows 98. Multiple instances of 
Oracle databases can be run using 
OSTART. See Chapter 7, on how to use 
OSTART.

On Windows NT:

Oracle registers a database instance as a 
service (OracleServiceSID).

To connect to and use an Oracle 
instance, an Oracle service is created 
during the database creation process 
and associated with the Oracle 
database. Once a service is created with 
the Oracle database, the service can run 
even while no user is logged on. This 
feature enables server security while 
running the Oracle database.

To Access Services:

By default, services run under the 
SYSTEM account. 

1. Choose Start > Settings > Control 
Panel > Services to access the 
Services dialog box. 

OracleServiceSID and other Oracle 
services appear here.
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Processes and Threads

See: Oracle Administration 
Assistant for Windows NT 
online help and Chapter 3, 
"Oracle9i Architecture on 
Windows" in this manual

Each Oracle background process 
exists as a separate process, for 
example, ora_dbw0_V816.

Each background process is 
implemented as a thread inside a single, 
large process. For each Oracle database 
instance or system identifier, there is 
one corresponding process for the 
Oracle9i database. For example, 100 
Oracle processes for a database instance 
on UNIX are handled by 100 threads 
inside one process on Windows.

All Oracle background, dedicated 
server, and client processes are threads 
of the master ORACLE process.

All the threads of the ORACLE process 
share resources on Windows 98/NT. 
This multithreaded architecture is 
highly efficient, allowing fast context 
switches with low overhead. 

To View Processes on Windows 98: 

You can use PVIEWER.EXE (Process 
Viewer of Microsoft C++ Developer 
Studio) to view processes and threads.

To View Processes on NT:

Use the Oracle Administration 
Assistant for Windows NT to view 
processes or kill individual threads. 

1. Choose Start > Programs > Oracle - 
HOME_NAME > Database 
Administration > Oracle 
Administration Assistant for 
Windows NT. 

2. Right-click the SID, for example 
V816, and choose Process 
Information.

Feature On UNIX... On Windows 98/NT...
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File Sizes

See: Appendix B, "Oracle8i 
Database Specifications for 
Windows 98"

UNIX file system (UFS) or 
journalled file system (JFS). 
Maximum file size supported by 
most vendors is now 32 GB.

The Oracle block sizes vary 
between 2-8K.

Oracle can be installed on FAT and 
NTFS1 file systems. By default, Oracle 
runs under the SYSTEM account, which 
does not have access to NTFS volumes, 
unless it is granted.

The maximum file size for FAT is 4 GB; 
for NTFS, 16 Exabytes (EB). 

The Oracle block size is based on the 
parameter DB_BLOCK_SIZE set in 
init.ora file. The maximum number of 
blocks per data file is 4 million on 
Windows NT. The maximum number of 
data files per database depends on 
block size. 

When calculating database limits, the 
total maximum capacity of the database 
remains the same regardless of the way 
the bits are split up.

Initialization Parameters: 
Multiple Database Writers

See: Oracle9i Database 
Specifications for Windows” 
in Oracle9i Personal Edition 
Database Administrator’s 
Guide for Windows

You can specify more than one 
database writer process with the 
initialization parameter             
DB_WRITERS_PROCESSES. 

Multiple database writers can 
help, for example, when a UNIX 
port does not support 
asynchronous I/O.

DB_WRITERS_PROCESSES, which 
writes dirty buffers to disk, is not 
supported. Windows 98/NT supplies 
its own I/O slaves and uses them to see 
if I/O is complete.

Multiple DB_WRITERS_PROCESSES 
might cause synchronization problems. 

Direct Writes to Disk

See: Oracle9i Database 
Concepts

On all three platforms, 
bypassing the file system buffer 
cache ensures the data is written 
to disk. 

Oracle uses the O_SYNC flag to 
bypass the file system buffer 
cache. The flag name depends on 
the UNIX port.

Oracle bypasses the file system buffer 
cache completely.

Feature On UNIX... On Windows 98/NT...
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Memory Resources

See: Oracle9i Database 
Concepts

The resources provided by the 
default kernels are often 
inadequate for a medium or large 
Oracle database. 

The maximum size of a shared 
memory segment (SHMMAX) 
and maximum number of 
semaphores available (SEMMNS) 
may be too low for Oracle 
recommendations.

Fewer resources are needed for 
interprocess communication (IPC) 
because the operating system is 
thread-based and not process-based. 
These resources, including shared 
memory and semaphores, are not 
adjustable by the user.

Install Accounts and Groups

See: “Administering a 
Database” in Oracle9i 
Personal Edition Database 
Administrator’s Guide for 
Windows

Uses the concept of a DBA group. 
The root account cannot be used 
to install Oracle. A separate 
Oracle account must be created 
manually.

On Windows 98 any user can install 
Oracle database, where as, on Windows 
NT Oracle must be installed by a 
Windows NT username in the 
Administrator’s group. The user name 
is automatically added to the Windows 
NT local group ORA_DBA, which 
receives the SYSDBA privilege. This 
allows the user to log into the database 
with the INTERNAL account and not 
be prompted for a password.

Password Files:

Password files are located in the 
ORACLE_BASE\ORACLE_
HOME\DATABASE directory and are 
named PWDSID.ORA, where SID 
identifies the Oracle8i database 
instance.

Dynamic Link Libraries (DLLs)

See:Oracle9i Database Concepts

Shared libraries are similar to the 
shared DLLs on Windows 98/NT. 
Object files and archive libraries 
are linked to generate the Oracle 
executables. Relinking is 
necessary after certain operations, 
such as installation of a patch.

Oracle DLLs form part of the executable 
at run time, and, therefore, are smaller. 
DLLs can be shared between multiple 
executables. Relinking by the user is not 
supported, but executable images can 
be modified using the ORASTACK 
utility.

Modifying Executable Images:

Modifying executable images on 
Windows 98/NT reduces the chances of 
running out of virtual memory when 
using a large SGA or an SGA with 
thousands of connections2. However, 
Oracle Corporation recommends doing 
this under the guidance of Oracle 
Support Services.

Feature On UNIX... On Windows 98/NT...
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Hot Backups

A (manual) hot backup is 
equivalent to backing up a 
tablespace that is in offline 
backup mode.

See: Oracle9i Personal Edition 
Database Administrator’s Guide 
for Windows and Oracle9i Backup 
and Recovery Concepts

The backup strategy on UNIX is 
as follows: put the tablespace into 
backup mode, copy the files to 
the backup location, and bring the 
tablespace out of backup mode.

Windows supports the same backup 
strategy, but you cannot copy files in 
use with normal Windows utilities. Use 
the Oracle utility OCOPY to copy open 
database files to another disk location. 
Then use a utility to copy the files to 
tape. 

Installation

See: Oracle9i Personal Edition 
Installation Guide for Windows 98

Many manual setup tasks 
required on UNIX are not 
required on Windows 98/NT.

You do not need to manually:

n set environment variables

n create a DBA group for database 
administrators

n create a group for users running 
Oracle Universal Installer

n create an account dedicated to 
installing and upgrading Oracle 
components

Feature On UNIX... On Windows 98/NT...
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Multiple Oracle Homes and 
OFA

Using multiple Oracle homes 
and Optimal Flexible 
Architecture (OFA) provides 
many advantages when 
administering large databases. 
OFA is implemented on 
Windows 98/NT and UNIX in 
the same way. However, 
differences exist with regard to 
the following:

n The top-level names of the 
OFA directory tree differ 
between Windows 98/NT 
and UNIX. However, the 
main subdirectory and file 
names are the same on both 
operating systems.

n ORACLE_BASE directory.

n No support for symbolic 
links on Windows 98/NT.

See: Chapter 5, "Multiple 
Oracle Homes and Optimal 
Flexible Architecture" in this 
manual

Multiple Oracle homes on 
Windows NT is comparable to 
installation capabilities on UNIX. 
Environment variables can be set 
to specify Oracle homes. 
ORACLE_BASE is associated 
with a UNIX user’s environment.

Symbolic Links

Symbolic links are supported. 
Although everything seems to be 
in one directory on the same hard 
drive, files can be on different 
hard drives if they are 
symbolically linked or have that 
directory as a mount point.

ORACLE_HOME directories can be 
located under a single ORACLE_BASE 
directory. ORACLE_BASE is defined in 
the registry (for example, in HKEY_
LOCAL_MACHINE 
\SOFTWARE\ORACLE\HOME0). Do 
not set ORACLE_HOME in the 
environment (software run from 
another Oracle home will not work 
reliably). In fact, beginning in release 
8.1.6, the Oracle Universal Installer will 
reset it. 

The goal of OFA is to place all Oracle 
software under one ORACLE_BASE 
directory and to spread the files across 
different physical drives as your 
databases increase in size. Oracle 
Corporation recommends that you use 
one logical drive to store your database 
administration files and that you place 
other files, as needed, on other logical 
drives in an ORADATA\DB_NAME 
directory.

For example, for a database named 
PROD, there are four logical drives:

n C:\ contains an Oracle home and 
the database administration files.

n F:\ contains the redo log files. (The 
F:\ drive could also represent two 
physical drives that have been 
striped to increase performance.)3

n G:\ contains one of the control files 
and all of the tablespace files. (The 
G:\ drive could also use a RAID 
Level-5 configuration to increase 
reliability.)4

n H:\ contains the second control 
file.

Symbolic Links

Symbolic links like those on UNIX are 
not supported, although Microsoft has 
announced the intention to support 
them in a near-future release.

Feature On UNIX... On Windows 98/NT...
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Automatic Startup/Shutdown

See: Oracle9i Database 
Administrator’s Guide and 
“Administering a Database” in 
Oracle9i Personal Edition Database 
Administrator’s Guide for 
Windows

Automatic Startup

Several files and scripts in 
different directories are used to 
start an instance automatically.

Automatic Shutdown

Scripts are run on computer 
shutdown, allowing applications 
such as Oracle to be shut down 
cleanly.

On Windows 98:

There is no automatic startup or 
shutdown of database available while 
running on Windows 98.

If the registry key HKEY_LOCAL_
MACHINE\SOFTWARE\HOMEID\ 
DATABASE_STARTUP is set to AUTO, 
then if no database instance is available 
while starting up SQL*Plus or 
SVRMGR, the instance whose SID is set 
to ORACLE_SID key will startup. If you 
want to change the value of 
DATABASE_STARTUP parameter, you 
can use ORAAUTO or Oracle9i Navigator 
(see Navigator help on how to modify 
registry keys for more information).

On Windows NT:

Automatic Startup

Set the registry parameter ORA_SID_
AUTOSTART to TRUE (the default) 
using an Oracle tool such as ORADIM.

1. Enter the following with 
parameters at the MS-DOS 
command prompt:

C:\> ORADIM PARAMETERS

2. To start the listener automatically, 
set the services startup type to 
automatic.

Automatic Shutdown

1. Set the registry parameters ORA_
SHUTDOWN and ORA_SID_
SHUTDOWN to stop the relevant 
OracleServiceSID and shut down. 

2. Set the registry parameter ORA_
SID_SHUTDOWNTYPE to control 
the shutdown mode (the default is 
I or Immediate).

Feature On UNIX... On Windows 98/NT...
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Diagnostic and Tuning Utilities

See: Chapter 4, "Database Tools 
Overview" in this manual and 
“Monitoring a Database” in 
Oracle9i Personal Edition Database 
Administrator’s Guide for 
Windows

Performance utilities are not 
included with the operating 
system. Utilities such as sar and 
vmstat are used to monitor Oracle 
background and shadow 
processes. These utilities are not 
integrated with Oracle.

Task Manager on Windows NT 
displays currently running 
processes and their resource 
usage, similar to the UNIX ps -ef 
command or OpenVMS SHOW 
SYSTEM. However, Task 
Manager is easier to interpret and 
the columns can be customized. 

On Windows 98:

Performance utilities include Task 
Manager, Control Panel, the Registry, 
PVIEWER.EXE (Process Viewer of 
Microsoft’s C++ Developer Studio) can 
be used to monitor processes and 
threads.

On Windows NT:

Performance utilities include Oracle 
Performance Monitor, Task Manager, 
Control Panel, Event Viewer, the 
registry, User Manager, and Microsoft 
Management Console (only 
included with Windows 2000). 

Oracle is integrated with several of 
these tools. For example:

n Oracle Performance Monitor 
displays key Oracle database 
information.

This tool is the same in appearance 
and operation as the Windows NT 
Performance Monitor, except it has 
been preloaded with Oracle9i 
database performance elements.

n Event Viewer displays system alert 
messages, including Oracle 
startup/shutdown messages and 
the audit trail.

Feature On UNIX... On Windows 98/NT...
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Raw Partitions Raw partitions are supported. Raw partitions are not supported on 
Windows 98.

On Windows NT:

Data files for tablespaces can be stored 
on a file system, or on raw partitions. A 
raw partition is a portion of a physical 
disk that is accessed at the lowest 
possible level.

Use the Windows NT Disk 
Administrator application to create an 
extended partition on a physical drive. 
An extended partition points to raw 
space on the disk that can be assigned 
multiple logical partitions for the 
database files. 

An extended partition avoids the 
four-partition limit on Windows NT by 
allowing you to define large numbers of 
logical partitions to accommodate 
applications using the Oracle8i 
database. Logical partitions can then be 
given symbolic link names to free up 
drive letters.

1 NTFS is available on Windows NT only.
2 On Windows 98 maximum 10 concurrent users are allowed.
3 Disk stripping is not supported on Windows 98.
4 RAID is not available for Windows 98.

Feature On UNIX... On Windows 98/NT...
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Oracle9i Architecture on Windows

This chapter describes how Oracle9i architecture takes advantage of some of the 
more advanced services in the Windows operating system.

This chapter contains these topics:

n Oracle9i on Windows Architecture

n Other Sources of Information
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Oracle9i on Windows Architecture
Oracle9i on Windows is a stable, reliable, and high performing system upon which 
to build applications. Each release of the database provides new platform-specific 
features above and beyond the generic database features for high performance on 
Windows.

Oracle9i operates the same way on Windows as it does on other platforms. The 
architecture offers several advantages on Windows, such as:

n Thread-Based Architecture

Thread-Based Architecture
The internal process architecture of the Oracle9i database is thread-based. Threads 
are objects within a process that run program instructions. Threads allow 
concurrent operations within a process so that a process can run different parts of 
its program simultaneously on different processors. A thread-based architecture 
provides the following advantages:

n Faster context switching

n Simpler System Global Area allocation routine, because it does not require the 
use of shared memory

n Faster spawning of new connections, because threads are created more quickly 
than processes

n Decreased memory usage, because threads share more data structures than 
processes

Internally, the code to implement the thread model is compact and separate from 
the main body of Oracle code. Exception handlers and routines track and 
de-allocate resources. They add robustness, with no downtime because of resource 
leaks or an ill-behaved program.

The Oracle9i database is not a typical Windows process. On Windows, an Oracle 
instance (the threads and memory structures) is a Windows service: a background 
process registered with the operating system. The service is started by Windows 
and requires no user interaction to start. This enables the database to open 
automatically at startup. 

When running multiple Oracle instances on Windows, each instance runs its own 
Windows service with multiple component threads. Each thread may be required 
for the database to be available, or it may be optional and specific to certain 
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platforms. Examples of optional and required threads on Windows are listed in 
Table 3–1.

Table 3–1 Required and Optional Oracle Threads

Oracle Thread Description Required/Optional

DBW0 database writer Required

LGWR log writer Required

PMON process monitor Required

SMON system monitor Required

CKPT checkpoint process (or thread on Windows) that 
runs by default on Windows

Optional

ARCH0 archive process (or thread on Windows) Optional

RECO distributed recovery background process Optional

Note: You can view running background processes by issuing the 
following query:

SQL> select * from v$bgprocess where paddr <> ’00’ ;
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Figure 3–1 Oracle architecture on Windows. The background processes read and 
write from the various datafiles, depending on your configuration. 

Oracle9i for Windows is supplied as a set of executables and dynamic link libraries 
(DLLs). Executable images can be modified using the ORASTACK utility to change 
the size of the stack used by the threads of the Oracle process. Oracle Corporation 
recommends you use this tool only under the guidance of Oracle Support Services.
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Other Sources of Information

See Also:

n Oracle9i Database Administrator’s Guide for Windows and Oracle9i 
Network, Directory, and Security Guide for Windows, on using the 
new Oracle9i features described in this chapter

n Chapter 2, "Oracle9i Differences between Windows 98, 
Windows NT, and UNIX"

n Chapter 4, "Database Tools Overview", for Oracle9i integration 
with Windows tools

n Chapter 8, "Developing Applications for Windows", for more 
Oracle9i integration with Windows features
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4
Database Tools Overview

Oracle9i Personal Edition for Windows 98 includes various tools to perform 
database functions. This chapter describes the preferred tools to perform common 
database administration tasks.

This chapter contains these topics:

■ Choosing a Database Tool

■ Starting Database Tools

■ Using SQL*Loader

■ Using Windows Tools
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Choosing a Database Tool
Database tools is a collective term for tools, utilities, and assistants that you can use 
to perform database administration tasks. Some database tools perform similar 
tasks, though no one database tool performs all database administration tasks. The 
following sections indicate which database tools can be used on particular 
operating systems and the preferred tools to use for common database 
administration tasks.

Database Tools and Operating System Compatibility
Table 4–1 lists database tools and the operating system(s) on which each can be 
used.

Note:

■ Oracle Server Manager is no longer shipped from of this 
release. All Server Manager text and examples have been 
replaced with SQL*Plus equivalents. 

■ Additionally, connecting to the database as CONNECT 
INTERNAL is no longer supported.

SQL> CONNECT INTERNAL/password@tnsalias

has been replaced by:

SQL> CONNECT SYS/password@tnsalias AS SYSDBA

Table 4–1 Database Tools and Operating System Compatibility

Database Tools Windows NT/2000 Windows 95/98

Application Development

SQL*Plus (SQLPLUS)1 Yes Yes

Pro*C/C++ Yes No

Pro*COBOL Yes No

Object Type Translator (OTT) Yes Yes

Oracle Services for Microsoft Transaction Server Yes No

Oracle Portal (formerly Oracle WebDB)2 Yes No
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Database Administration 

Oracle Enterprise Manager3 Yes No

SQL*Plus (SQLPLUS) Yes Yes

Oracle Database Configuration Assistant Yes No

Oracle Advanced Security4 Yes No

Oracle Performance Monitor for Windows NT Yes No

Migration Utilities

Oracle Data Migration Assistant Yes Yes

Oracle Migration Workbench5 Yes No

Oracle Utilities from the Command Line

Migration Utility (MIG) Yes Yes

DBVERIFY (DBVERF) Yes Yes

Export Utility (EXP)6 Yes Yes

Import Utility (IMP)7 Yes Yes

OCOPY Yes Yes

ORADIM8 Yes Yes

Password Utility (ORAPWD)9 Yes Yes

Recovery Manager (RMAN) Yes Yes

SQL*Loader (SQLLDR) Yes Yes

TKPROF Yes Yes

OPERFCFG Yes No

Network Administration

Oracle Net Manager Yes Yes

Oracle Net Configuration Assistant Yes Yes

Table 4–1 (Cont.) Database Tools and Operating System Compatibility

Database Tools Windows NT/2000 Windows 95/98
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Windows Tools

Task Manager Yes Yes

Control Panel Yes Yes

Event Viewer Yes No

Registry Editor Yes Yes

User Manager Yes10 No

Microsoft Management Console Yes11 No

1 The ORADEBUG utility can be used through SQL*Plus to send debug commands to Oracle processes. See “Using the 
ORADEBUG Utility” in Oracle9i Personal Edition Database Administrator’s Guide for Windows.

2 Available on a separate CD-ROM.
3 Oracle Enterprise Manager and its optional management packs have additional integrated tools to assist in managing 

databases. See the Oracle Enterprise Manager Concepts Guide for more information.
4 Includes Enterprise Login Assistant and Oracle Wallet Manager. Available only with Oracle9i Enterprise Edition and 

Oracle9i Personal Edition, and not Oracle9i Standard Edition. See your installActions.log at C:\program 
files\Oracle\Inventory\logs.

5 Available on a separate CD-ROM.
6 The VOLSIZE parameter for the Export and Import utilities is not supported on Windows NT. If you attempt to use the 

utilities with the VOLSIZE parameter, then error LRM-00101 occurs. For example: 
D:\> exp system/manager full=y volsize=100m; 
LRM-00101: unknown parameter name ’volsize’ 
EXP-00019: failed to process parameters, type ’EXP HELP=Y’ for help 
EXP-00000: Export terminated unsuccessfully

7 See footnote 6.
8 ORADIM operates only on local databases.
9 ORAPWD does not work on password files for remote databases.
10 Windows NT only.
11 Must be obtained from Microsoft Corporation for use with Windows NT 4.0; automatically included with Windows 2000.

Table 4–1 (Cont.) Database Tools and Operating System Compatibility

Database Tools Windows NT/2000 Windows 95/98
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Preferred Database Tools
This table lists common database administration tasks and the various database 
tools you can use to perform them. Oracle Corporation recommends you use the 
tools listed in the " Preferred Database Tools" column of the table Table 4–2. After 
choosing a tool to perform a task, go to "Starting Database Tools" on page 4-6 for 
instructions on how to start the tool

Table 4–2 Preferred Database Tools

Database Administration Task Preferred Database Tool Other Database Tools

Create a database Oracle Database Configuration 
Assistant

Delete a database Oracle Database Configuration 
Assistant

Start a database Oracle Start Utility (OSTART) SQL*Plus

Shut down a database Oracle Stop Utility (OSTOP) SQL*Plus and KNLSTOP 
together

Change internal database 
passwords

ORAPWD

Migrate a database Oracle Data Migration Assistant1 Migration Utility (MIG)

Upgrade a database Oracle Data Migration Assistant Run provided scripts in 
SQL*Plus

Export data Export Utility (EXP)

Import data Import Utility (IMP)

Load data SQL*Loader (SQLLDR)

Back up a database ■ Recovery Manager (RMAN)

■ OCOPY2

Recover a database ■ Recovery Manager (RMAN)

■ OCOPY

Authenticate Database 
Administrators and Users

SQL*Plus
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Starting Database Tools
This section describes how to start each of the database tools in the following 
categories:

■ Starting Database Tools in Multiple Oracle Homes

■ Starting Database Tools from the Start Menu

■ Starting Database Tools from the Command Line

■ Starting Windows 98 Tools

You will be referred back to this section for database tool startup procedures as you 
use this manual.

Create database objects3 Oracle9i Navigator SQL*Plus

Create a database Oracle Database Configuration 
Assistant

Grant Database Roles Oracle9i Navigator SQL*Plus
1 Oracle Data Migration Assistant can only be used to upgrade Release 7.x, 8.0.x or 8.1.5 databases to Release 8.1.6. It cannot 

be used to upgrade an earlier Oracle7 database release to a later Oracle7 database release. See your Oracle7 for Windows 95 
documentation for information on how to upgrade from an earlier Oracle7 release to a later Oracle7 release.

2 Do not back up files while you are shutting down the database, otherwise your backup will be invalid. You cannot use an 
invalid backup to restore files at a later date. See Oracle8i Backup and Recovery Guide for more information.

3 See Oracle8i Administrator’s Guide for guidelines on creating databases objects. This guide provides equations for estimating 
the space requirements for clusters, non-clustered tables, and indexes. Windows 98 uses the same fixed header, transaction 
header, and row header constants described in this guide. 

Table 4–2 (Cont.) Preferred Database Tools

Database Administration Task Preferred Database Tool Other Database Tools
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Starting Database Tools in Multiple Oracle Homes
If you have multiple Oracle homes on your computer from previous releases, then 
see Chapter 5, "Multiple Oracle Homes and Optimal Flexible Architecture" for a 
description of the differences between Oracle homes before and after Oracle9i 
Release 1 (9.0.1.1.0).

Starting Tools from Oracle8 Release 8.0.4 and Later 8.0.x Multiple Oracle Homes
If you are using multiple Oracle homes, then the command to start a tool from any 
home other than the first includes a HOME_NAME, where HOME_NAME indicates 
the name of that Oracle home. The first Oracle home created on your computer does 
not have HOME_NAME appended to the group. For example:

To start SQL*Plus from the first Oracle home, choose:

Start > Programs > Oracle > Application Development > SQL Plus 

To start SQL*Plus from an additional Oracle home, choose:

Start > Programs > Oracle - HOME_NAME > Application Development > SQL Plus

Starting Tools from Oracle8i Release 8.1.3 and Later Multiple Oracle Homes
Beginning in Oracle8i Release 8.1.3, each Oracle home, including the first Oracle 
home you create on your computer, has a unique HOME_NAME. For example:

To start Oracle Administration Assistant from any Oracle home, choose:

Start > Programs > Oracle - HOME_NAME > Database Administration > Database 
Configuration Assistant, where HOME_NAME is the name of the Oracle home. 
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For example, either HOME1 or HOME2 in the following figure:

Taskbar pathname for first 
Oracle database installation. 
A home name of HOME1 
appears in the pathname. 

Taskbar pathname for 
second Oracle database 
installation. A home name 
of HOME2 appears in the 
pathname. 
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Starting Database Tools from the Start Menu
Table 4–3 describes how to start assistants and other tools from the Start Menu. It 
also tells where to go for further information on using these products.

Note: When you use an assistant, you must have read and write 
access to the directory where database files will be moved or 
created. To create an Oracle9i database, you must have an 
administrative privilege. If you run Oracle Database Configuration 
Assistant from an account that is not part of the Administrators 
group, then the tool exits without completing the operation.

Table 4–3 Starting Database Tools from the Start Menu

Tool Start Menu Path More Information

Data Migration 
Assistant

Start > Programs > Oracle - HOME_NAME 
> Migration Utilities > Data Migration 
Assistant

Oracle9i Database Migration

Database 
Configuration 
Assistant

Start > Programs > Oracle - HOME_NAME 
> Configuration and Migration Tools > 
Database Configuration Assistant

"Using Oracle Database Configuration 
Assistant" in Oracle9i Personal Edition 
Database Administrator’s Guide for 
Windows

INTYPE File 
Assistant

Start > Programs > Oracle - HOME_NAME 
> Application Development > INTYPE File 
Assistant

INTYPE File Assistant online help

Microsoft ODBC 
Administrator

Start > Programs > Oracle - HOME_NAME 
> Configuration and Migration Tools > 
Microsoft ODBC Administration

Microsoft ODBC Administration online 
help

Net Configuration 
Assistant

Start > Programs > Oracle - HOME_NAME 
> Configuration and Migration Tools > Net 
Configuration Assistant

Oracle9i Net Services Administrator’s 
Guide

Net Manager Start > Programs > Oracle - HOME_NAME 
> Configuration and Migration Tools > Net 
Manager

Oracle9i Net Services Administrator’s 
Guide

SQL*Plus Start > Programs > Oracle - HOME_NAME 
> Application Development > SQL*Plus

SQL*Plus User’s Guide and Reference 

"Starting and Shutting Down a 
Database with SQL*Plus" in Oracle9i 
Personal Edition Database Administrator’s 
Guide for Windows 
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Starting Database Tools
The following table describes how to start most tools, and where to go for further 
information on using these products:
 

Starting Database Tools from the Command Line
Table 4–4 describes how to start Oracle database tools from the command line, and 
where to go for further information on using these products.

Tool Choose Start > Programs > Oracle - HOME_NAME > For More Information, See...

Oracle Data 
Migration 
Assistant

Migration Utilities > Data Migration Assistant ■ Oracle9i Migration 

■ Oracle9i Personal Edition 
Installation Guide for Windows 
98

Oracle Database 
Configuration 
Assistant

Database Administration > Database Configuration 
Assistant

■ Oracle9i Installation Guide for 
Windows 98

Net Manager Configuration and Migration Tools >Net Manager Oracle9i Net Services 
Administrator’s Guide

Net 
Configuration 
Assistant

Configuration and Migration Tools > Net Configuration 
Assistant

Oracle9i Net Services 
Administrator’s Guide
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Table 4–4 Starting Database Tools from the Command Line

Tool Enter at Prompt More Information

DBVERIFY C:\> dbv

DBVERIFY starts and prompts you for a 
filename parameter. To obtain a list of 
parameters, enter:

C:\> dbv help=y

Oracle9i Database Utilities

Export Utility1 C:\> exp username password

EXP starts and prompts you for parameters. 
To obtain a list of these parameters, enter:

C:\> exp help=y

Oracle9i Database Utilities for instructions on 
use of the Export Utility

Oracle9i Database Error Messages for 
information on error messages

Import Utility2 C:\> imp username password

IMP starts and prompts you for parameters. 
To obtain a list of these parameters, enter:

C:\> imp help=y

Oracle9i Database Utilities 

Oracle9i Database Error Messages 

Migration Utility C:\> mig

To obtain a list of parameters, enter:

C:\> mig help=y

Oracle9i Database Migration

OCOPY C:\> ocopy "Backing Up Files with the OCOPY Utility” 
in Oracle9i Personal Edition Database 
Administrator’s Guide for Windows

ORADIM C:\> oradim parameters

To get a complete listing of ORADIM 
parameters, enter:3

C:\> oradim -? | -h | -help

“Using the ORADIM Utility to Administer 
an Oracle Instance” in Oracle9i Personal 
Edition Database Administrator’s Guide for 
Windows

Password Utility 
(ORAPWD)

C:\> orapwd

The password file is hidden. Use Windows 
Explorer to see it in a file list. Choose View > 
Options > View > Show All Files 

“Creating Password Files” in Oracle9i 
Personal Edition Database Administrator’s 
Guide for Windows

Recovery 
Manager 
(RMAN)

C:\> rman parameters Oracle9i Personal Edition Database 
Administrator’s Guide for Windows 

Oracle9i Recovery Manager User’s Guide 
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Starting Windows 98 Tools
This table describes how to start Windows 98 tool, and where to go for more 
information on using this product: 

 

Using SQL*Loader
This section describes Windows 98-specific information for using SQL*Loader 
(SQLLDR).

SQL*Plus 
(SQLPLUS)

C:\> sqlplus SQL*Plus User’s Guide and Reference 

“Starting and Shutting Down a Database 
with SQL*Plus” in Oracle9i Personal Edition 
Database Administrator’s Guide for Windows 

SQL*Loader 
(SQLLDR)

C:\> sqlldr

SQL*Loader displays a Help screen with the 
available keywords and default values.

Oracle9i Database Utilities 

Oracle9i Database Error Messages 

"Starting Windows 98 Tools" on page 4-12 in 
this manual

TKPROF C:\> tkprof Oracle9i Database Performance Guide and 
Reference

1 When running the Export Utility on Windows, the default values for the BUFFER and RECORDLENGTH parameters are 4 KB 
and 2 KB respectively. This default RECORDLENGTH parameter does not depend on the value of BUFSIZ defined in the system 
header file. If you specify a value larger than USHRT_MAX (64 KB), you will get a warning message. The VOLSIZE parameter 
for the Export Utility is not supported on Windows. To export an entire database, you must use the EXP_FULL_DATABASE 
role.

2 See footnote 1.
3 Entering oradim without any options also displays a listing of parameters.

Windows 98 
Tools

To Start... For More Information, See...

Registry ■ Enter the following at the MS-DOS command 
prompt on Windows 98:

C:\> REGEDIT

The registry editor window appears.

■ "Registry" on page 4-14

■ Chapter 7, "Configuration 
Parameters and the 
Registry"

■ Your Microsoft Windows 98 
documentation

Table 4–4 (Cont.) Starting Database Tools from the Command Line

Tool Enter at Prompt More Information
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Windows 98 Processing Options
These are the possible values for the Operating System Dependent (OSD) file 
processing specifications string option, referred to in the "SQL*Loader Control File 
Reference" chapter of Oracle9i Database Utilities. 

Direct Path Option
SQL*Loader includes a direct path option that bypasses Oracle8i for Personal 
Edition redo log and data verification features, thereby decreasing loading time. 
Use the direct path option with data files known to be error free.

Control File Conventions
When preparing a SQL*Loader control file (.CTL), you must follow certain syntax 
and notational conventions. When specifying datatypes in the SQL*Loader control 
file, note that the default sizes of native datatypes are specific to Windows 98. You 
cannot override these defaults in the control file. 

Processing Option Description

""1 

1 Two double quote characters with no space in between.

Stream record format in which each record is terminated by a newline character. The 
maximum record size is 48 KB.

"FIX n" Fixed record format in which each record is exactly n bytes long. If the record is 
terminated by a newline character, the newline character must be the nth byte. Note 
that the Oracle9i Database Utilities guide refers to this control file option as 
"RECSIZE".

"VAR xxxx" Load variable length records. Specify the OSD "VAR recsizehint" in the control file for 
this option to take effect. The xxxx gives an estimate of the average record size to 
SQL*Loader so that it can approximate buffer sizes accurately and not waste 
memory. The default length is eighty characters. The xxxx does not specify how 
many leading bytes of length are included in each record. It only acts as a hint to 
SQL*Loader. Each record must always be preceded by five ASCII bytes containing 
the length of the remainder of the record. For example, a record must look like the 
following: 

00024 This is a 24 byte string 

Any whitespace, carriage returns, or linefeeds at the end of the record are ignored 
unless specifically included in the byte count in the length field. 
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Using Windows Tools
The following Windows 98 tool can be used to administer an Oracle database:

■ Registry

Registry
The Oracle database stores its configuration information in a structure known as the 
registry. You can view and modify this configuration information through the 
registry editor. The registry contains configuration information for your computer, 
and must not be accessible for editing by inexperienced users. Only experienced 
administrators should view and change this information.

The registry editor displays configuration information in a tree-like format 
consisting of four keys (or folders). These keys are shown in the tree view in the 
left-hand window. In the right-hand window, the parameters and values assigned 
to that key are displayed. 

What Database Parameters Are Configured?
When you install products from your CD-ROM, configuration parameters are 
automatically entered in the registry. These parameters are read each time your 
Windows 98 computer is restarted and whenever an Oracle product is launched. 
These parameters include settings for:

■ Oracle home directory

■ Language

■ Company name

Native Datatypes Default Field Length

DOUBLE 8

FLOAT 4

INTEGER 4

SMALLINT 2

See: Oracle9i Database Utilities for a complete list of options and 
instructions on using SQL*Loader.
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■ Oracle home subdirectories for individual products

■ Individual products such as SQL*Plus

The following figure shows some of the Oracle database configuration parameters 
in the registry: 

     

See: See Chapter 7, "Configuration Parameters and the Registry" 
for definitions of Oracle database configuration parameters and 
specific instructions on using the registry to modify Oracle 
database configuration parameters.
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5
Multiple Oracle Homes and Optimal Flexible

Architecture

This chapter describes the concepts of multiple Oracle homes and Optimal 
Flexible Architecture (OFA) for Oracle9i Personal Edition for Windows 98.

This chapter contains these topics:

■ Introduction to Multiple Oracle Homes and OFA

■ Multiple Oracle Homes Overview

■ Changing the Value of PATH

■ Exiting Oracle Universal Installer After Entering Name and PATH

■ Setting Variables in the Environment or the Registry

■ Optimal Flexible Architecture Overview

■ Differences Between Directory Trees by Release

■ OFA Directory Naming Conventions

■ OFA and Multiple Oracle Home Configurations
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Introduction to Multiple Oracle Homes and OFA
When you install an Oracle database, you are installing one of the largest 
applications that your computer can support. Using multiple Oracle homes and 
OFA provides many advantages when administering large databases. The following 
advantages are the most important:

■ Structured organization of directories and files and the consistent naming used 
for database files simplify database administration.

■ Distribution of I/O across multiple disks prevents performance bottlenecks 
caused by multiple read or write commands issued simultaneously to a single 
drive.

■ Distribution of applications across multiple disks safeguards against database 
failures.

■ Login home directories are not at risk when database administrators add, move, 
or delete Oracle home directories.

■ Multiple versions of application software can execute concurrently.

■ Software upgrades can be tested in an Oracle home in a separate directory from 
the Oracle home where your production database is located.

Multiple Oracle Homes Overview
This section includes the following topics:

■ What Is an Oracle Home?

■ Benefit of Using Multiple Oracle Homes

■ Multiple Oracle Home Functionality in Different Releases

■ One-Listener Support of Multiple Oracle Homes

■ Multiple Oracle Home Environments

Note: All Oracle7 products and all Oracle8 Release 8.0.3 products 
are non-multiple Oracle home products. Your Oracle9i Personal 
Edition Installation Guide for Windows 98 has a list of products 
supporting single or multiple Oracle homes.
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What Is an Oracle Home?
An Oracle home corresponds to the environment in which Oracle products run. 
This environment includes the following:

■ Location of installed product files (for example, C:\orawin95 or 
C:\oracle\ora90)

■ PATH variable pointing to the binary files of installed products

■ Registry entries 

■ Service names

■ Program groups

Oracle homes also have a name associated with them, which you specify along with 
their location during installation.

Benefit of Using Multiple Oracle Homes
The main benefit of using multiple Oracle homes is that you can run multiple 
releases of the same products concurrently. For example, you can test an Oracle9i 
Release 1 (9.0.1.1.0) database patch before you run your production database 
Oracle9i Release 1 (9.0.1.1.0) against it. 

Multiple Oracle Home Functionality in Different Releases
Modifications to multiple Oracle home functionality have occurred since it was 
introduced in Oracle8 Release 8.0.4. This section helps you determine the 
capabilities of your Oracle home depending on the release you are using.

Oracle8 Releases Before 8.0.4
Releases of Oracle for Windows NT and Windows 95 prior to Oracle8 Release 8.0.4 
support only single Oracle homes, allowing you to install and run Oracle products 
in a single Oracle home. Different releases of Oracle products can be installed in the 
same Oracle home provided they have different first or second-digit release numbers. 
For example, you can install Oracle7 Release 7.2 products and Oracle7 Release 7.3 
products or Oracle7 Release 7.x and Oracle8 Release 8.x products in the same Oracle 
home. However, you cannot install multiple third-digit releases of the same 
products. For example, you cannot install Oracle7 Release 7.3.2 and Oracle7 Release 
7.3.3 products on the same computer; one installation will overwrite the other.
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Oracle8 Releases 8.0.4 to 8.0.6
You can install one or more releases of Oracle products in multiple Oracle homes. 
For example, with multiple Oracle homes, you can install Oracle8 Release 8.0.x and 
Oracle8i Release 8.1.3 products or Oracle7 Release 7.x and Oracle8 Release 8.0.x 
products in different Oracle homes on the same computer.

You can also install different releases of Oracle products in the same Oracle home 
provided they have different first or second-digit release numbers. For example, 
you can install Oracle7 Release 7.2 products and Oracle8 Release 8.0.x products in 
the same Oracle home.

Oracle8i Release 8.1.3 to Oracle9i Release 1 (9.0.1.1.0)
These releases have the same multiple Oracle home functionality as Oracle8 releases 
8.0.4 to 8.0.6, but the following restrictions apply:

■ You cannot install any release from Oracle8i Release 8.1.3 to Oracle9i Release 1 
(9.0.1.1.0) into an Oracle home that was created using the old installer. (The old 
installer was called Oracle Installer and was used for installations before 
Oracle8i Release 8.1.3; the new Java-based installer is called Oracle Universal 
Installer.)

■ You cannot install releases prior to Oracle8i Release 8.1.3 into an Oracle home 
that was created by any release from Oracle8i Release 8.1.3 to Oracle9i Release 1 
(9.0.1.1.0).

■ Releases from Oracle8i Release 8.1.3 to Oracle9i Release 1 (9.0.1.1.0) must be 
installed in separate Oracle homes. You cannot have more than one release 
installed in each Oracle home.

Oracle8i Release 8.1.5 to Oracle9i Release 1 (9.0.1.1.0)
You can use an Oracle9i Release 1 (9.0.1.1.0) listener to spawn a connection to a 
database from Oracle9i Release 1 (9.0.1.1.0), Oracle8i Release 8.1.x, Oracle8 Release 
8.0.x, or Oracle7 Release 7.3.x. Some restrictions apply, however, in using Oracle9i 
Release 1 (9.0.1.1.0) listeners with the earlier releases of the database:

■ You should enable process mode external procedures for Oracle9i Release 1 
(9.0.1.1.0) if you want to spawn a connection to a Oracle8 Release 8.0.3 database.

■ You must install the Oracle8 Release 8.0.4.0.3 (or later) patch for Oracle Net.

■ You cannot enable shared sockets.
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One-Listener Support of Multiple Oracle Homes
You can use one listener for spawning connections to databases for multiple Oracle 
homes. Simply add each system identifier to the SID_LIST section in the ORACLE_
BASE\ORACLE_HOME\network\admin\listener.ora file.

Because the SID is unique to a system across different Oracle homes, the listener can 
spawn the database thread for a specific SID in the correct Oracle home, and the 
ORACLE_HOME parameter (used in UNIX environments only) is not needed in the 
listener.ora file.

Multiple Oracle Home Environments
This section describes the differences among multiple Oracle home environments 
since they were first introduced in Oracle8 Release 8.0.4.

Oracle Home Environments in Oracle8 Releases 8.0.4 and Later 8.0.x
If you have Oracle8 Release 8.0.4 or later 8.0.x Oracle homes on your computer, then 
note the differences in Table 5–1 between the first Oracle home you installed and 
more recent Oracle homes you may install.

WARNING: Multiple Oracle homes functionality works only 
with Oracle8 Releases 8.0.4 and later. For example, if you have 
Oracle7 Release 7.3.3 products already installed on your 
computer, then it does not work. You cannot install Oracle7 
Release 7.3.4 products in a separate Oracle home.

Note: There may be multiple listener.ora files on your 
computer, one for each Oracle home. To ensure that you use the 
correct listener.ora file, check the Oracle home name in the 
listener service. See "Managing Oracle Services" in Oracle9i Personal 
Edition Database Administrator’s Guide for Windows for information 
on verifying service names.
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Oracle Home Environments in Oracle8i Releases 8.1.3, 8.1.4, and 8.1.5
Oracle8i Release 8.1.3, 8.1.4, and 8.1.5 Oracle homes are slightly different from 
Oracle homes before Oracle8i Release 8.1.3. Table 5–2 displays those differences.

Table 5–1 Oracle Home Environments in Oracle8 Releases 8.0.4 and Later 8.0.x

Element First Oracle Home Each Additional Oracle Home

Program Groups Oracle for Windows 98 Oracle for Windows - HOME_NAME

Oracle home name appended to the program group.

Registry Entries Located in HKEY_LOCAL_
MACHINE\SOFTWARE\ORACL
E

Subkeys for each Oracle home are added below the 
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE subkey 
(HOME0, HOME1, HOME2, and so on). For more information 
on the registry keys and subkeys, see Chapter 7, 
"Configuration Parameters and the Registry" in this 
manual.

System Identifier 
(SID) name for 
starter database

Automatically named ORCL Only the first starter database on your computer is called 
ORCL. Additional starter databases use the naming 
convention ORCx or ORxx where x is a number appended 
to ensure the SID is unique.

Table 5–2 Oracle Home Environments in Oracle 8i Releases 8.1.3, 8.1.4, and 8.1.5

Element First Oracle Home Each Additional Oracle Home

Program Groups Oracle - HOME_NAME Oracle - HOME_NAME

Registry Entries Located in HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\
HOME0

Subkeys for each Oracle home are added in the 
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE 
subkey. For example, the next subkeys after HOME0 
are HOME1, HOME2, HOME3, and so on. For more 
information on the registry keys and subkeys, see 
Chapter 7, "Configuration Parameters and the 
Registry" in this manual.

System Identifier 
(SID)1 name and 
DB_NAME

1 For Oracle8i releases 8.1.3 through 9.0, the SID can be a maximum of 64 alphanumeric characters in length. For all Oracle for 
Windows releases prior to 8.1.3, the SID is a maximum of 4 alphanumeric characters.

Automatically named ORCL for 
Oracle8i releases 8.1.3 and 8.1.4.

For Oracle8i Releases 8.1.3 and 8.1.4, the second 
database you create on your computer has a SID of 
ORCL0. For Oracle8i Release 8.1.5 and onwards, you 
must type in the global database name and SID name 
of your choice when prompted during installation.
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Changing the Value of PATH
Unless you specify otherwise at installation time, the Oracle home in which you 
installed products most recently is the first directory listed in your PATH (primary 
home). As such, it has priority over the other Oracle home entries in your PATH.

If you start a product from the MS-DOS command prompt, then the release of the 
product started is the one in the Oracle home listed first in your PATH, unless you 
specifically start a different release of the product by one of the following methods:

■ Specifying the full directory path name to the release of the product you want 
to use at the MS-DOS command prompt

■ Changing to the directory that contains the executable you want to use

■ Changing your PATH so that the first entry points to the binary files for the 
product release you want to use

You can change the value of PATH by using one of the following methods:

■ Using Oracle Home Selector

■ At the System Level 

You can assign a new value at the system level. The new value exists until you 
change the value of PATH again.

■ At the MS-DOS command prompt

You can assign a new value at the MS-DOS command prompt. The new value 
reverts to its previous value when you quit the session.

Note: The first two methods of changing the value of PATH are 
only valid if you are a member of the Administrators group. After 
you have changed the value of PATH, you must open a new 
MS-DOS command prompt window to make it active. The change 
is not reflected in already-opened windows.
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Using Oracle Home Selector
Oracle Home Selector is a graphical user interface tool that enables you to edit your 
environment path to make an appropriate Oracle home directory your primary 
home. This tool can be used only when you have multiple, active Oracle home 
directories on a single computer.

1. Choose Start > Programs > Oracle Installation Products > Home Selector.

The Oracle Home Selector window appears.

2. Select the Oracle home that you want as the primary Oracle home from the 
drop-down list.

3. Choose OK.

At the System Level
To change the value of PATH at the system level on Windows 95 or 98:

1. Open the autoexec.bat file.

2. Edit the value of the PATH statement.

3. Restart your computer.
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In some cases on Windows 95 and Windows 98, the Oracle Home Selector fails to 
switch the entries in the PATH environment variable as desired. This occurs where 
the PATH is defined in multiple places in the file autoexec.bat. 

For example, if the following lines exist in autoexec.bat: 

PATH C:\windows 
PATH D:\oracle\ora817;D:\oracle\ora816;%PATH% 

then an attempt to switch the order of D:\oracle\ora817 with 
D:\oracle\ora816 in the PATH using Oracle Home Selector fails. 

To work around this limitation, modify autoexec.bat so that the PATH is defined 
in one location in the file. Using the previous example, modify autoexec.bat to 
read: 

PATH D:\oracle\ora817;D:\oracle\ora816;C:\windows 

If you then attempt to use Oracle Home Selector to switch the order of Oracle 
homes in the PATH, it will succeed.

At the MS-DOS command prompt
At the MS-DOS command prompt, enter:

C:\> set PATH=PATHNAME;%PATH%

where PATHNAME is the full path to the binary files for the products you want to 
use. This change is valid for the current session only. If you want to change the 
value of your PATH permanently, then use Oracle Home Selector or change the 
value of PATH at the system level. Both methods are described earlier in this section.
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Exiting Oracle Universal Installer After Entering Name and PATH
If you have to exit Oracle Universal Installer unexpectedly after you have entered 
the name and path for an Oracle home (for example, because there is no more disk 
space in the path you specified), then you cannot specify a different path until you 
delete the HOMEID key and the IDx key corresponding to that Oracle home from the 
registry. To do this:

1. Read the value of the ORACLE_HOME_NAME parameter for each HOMEID subkey 
in the HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE key until you find the 
value that matches the name of the Oracle home you must delete.

2. Delete the HOMEID subkey you just located.

3. Delete the appropriate IDx subkey in the HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\ALL_HOMES key, where x has the same value 
as the ID in HOMEID. For example, if the HOMEID subkey for the home name 
you want to delete is HOME1, then the appropriate IDx subkey is ID1.

Setting Variables in the Environment or the Registry
Variables set in the environment always override the value of equivalent variables 
set in the registry. The following section describes the consequences of setting two 
of the most commonly-used environment variables, ORACLE_HOME and TNS_
ADMIN.

ORACLE_HOME
Oracle Corporation recommends that you never set the ORACLE_HOME environment 
variable, because it is not required for Oracle products to function properly. If you 
set the ORACLE_HOME environment variable, then Oracle Universal Installer will 
unset it for you. Oracle products find the value of ORACLE_HOME at the location 
specified by the ORACLE_BASE\ORACLE_HOME\bin\oracle.key file. If you 
must set ORACLE_HOME in the environment for another reason, then you must take 
care to run software only from that Oracle home when the variable is set. 

When you run an Oracle application from the MS-DOS command prompt, the first 
executable by that name found in the directory path runs. For example, C:\> 

See Also: Chapter 7, "Configuration Parameters and the Registry" 
in this manual for more information on the registry keys and 
subkeys
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sqlplus. Alternately, if you specify a full directory path, then the specified 
application runs. For example, C:\oracle\ora90> sqlplus.

If you modify the value of PATH using any of the four methods described in the 
previous section, then you can choose which release of an application is run from 
the MS-DOS command prompt. In sum, modifying the value of PATH indicates 
from which Oracle home to run executables at the MS-DOS command prompt, 
when no full directory path is specified. 

Once an Oracle application starts, it looks for all environment variables first in the  
current environment and second in the registry key for the Oracle home from which 
the application is running.

The application knows where it is running from by calling Windows to obtain the 
executable’s path name and then parsing the path name to get the directory from 
which it is running. In the ORACLE_BASE\ORACLE_HOME\bin directory where the 
executable resides, there is a file called oracle.key. This file specifies where in the 
registry to look for variables when applications from that particular Oracle home 
are run. 

For example, if you run C:\oracle\ora90\bin\sqlplus.exe, then 
sqlplus.exe looks in C:\oracle\ora90\bin\oracle.key to find out where 
to look for its registry variables. If the oracle.key file does not exist (for version 7 
and some version 8 Oracle homes), then Oracle uses HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE to locate the registry variables. 

In a typical case, there are no Oracle variables (that is, ORACLE_HOME) set in the 
environment. Any applications run from an Oracle8 Release 8.0.5 or later Oracle 
home look in the oracle.key file in that Oracle home and find their variables 
(including ORACLE_HOME) in the correct registry key. Likewise for Oracle9i Release 
1 (9.0.1.1.0), the Oracle home that gets priority depends on the PATH, but regardless 
of the PATH setting, all the software works correctly. 

Consequences of Setting ORACLE_HOME
If you set ORACLE_HOME in the environment, then software run from another Oracle 
home will not work reliably. The conflict occurs when you set ORACLE_HOME to 
point to one Oracle home directory, then attempt to run applications from a second 
Oracle home. These applications first check for any environment variable settings 
(such as ORACLE_HOME), before checking the registry through the oracle.key 
file. Because ORACLE_HOME is set, the applications in the second Oracle home 
attempt to use files in the first Oracle home, causing a conflict.
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For example, suppose you have Oracle8 Release 8.0.5 installed in C:\orawin95 
and Oracle9i Release 1 (9.0.1.1.0) installed in C:\oracle\ora90. Suppose further 
that ORACLE_HOME is set to C:\orawin95 in the environment. If you run an 
application from C:\oracle\ora90\bin, then that application first looks in the 
environment for all variables before looking at its oracle.key file. So an 
application run from your Oracle9i Release 1 (9.0.1.1.0) Oracle home runs with 
ORACLE_HOME=C:\orawin95. Therefore, anything that the application uses 
ORACLE_HOME for will be looked for in C:\orawin95, where it may not exist. 
Examples include message files (*.msb), SQL scripts (.sql), and any other files 
opened by the application and based off ORACLE_HOME. 

Note that the same behavior occurs on UNIX. If you run an application from Oracle 
home number 1 with ORACLE_HOME=OracleHome number 2 in the environment, 
then the same behavior can be observed. 

TNS_ADMIN
Oracle software looks for TNS_ADMIN in one location in the registry (depending 
upon the type of Oracle home installed). If you installed software into the default 
Oracle home, then any software running from that Oracle home will look in HKEY_
LOCAL_MACHINE\SOFTWARE\ORACLE. If you installed a new-style (8.0.4 or later) 
multiple Oracle home, then the Oracle software looks in HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\HOMEID. (The ALL_HOMES key is used by the 
installer and plays no role when translating variables.)

The environment always overrides the registry, so if TNS_ADMIN is set in the 
environment, then that takes precedence over the TNS_ADMIN setting in the registry. 
No variables should be set in the environment by the Oracle Home Selector except 
for the PATH.

Optimal Flexible Architecture Overview
Oracle Optimal Flexible Architecture (OFA) is a set of file naming and placement 
guidelines for Oracle software and databases. It can also be thought of as a set of 
good habits to adopt when organizing Oracle directories and files on your computer. 
All Oracle products on CD-ROM are OFA-compliant; that is, Oracle Universal 
Installer places Oracle products in directory locations that follow the OFA 
guidelines. Although using OFA is not a requirement, Oracle Corporation 
recommends that you use it if your database will grow in size, or if you plan to have 
multiple databases. 
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The aim of OFA is to prevent an entire class of problems that can occur when you 
have different releases of Oracle software and multiple, growing databases on your 
computer. OFA is designed to provide significant benefits:

■ Easier maintenance of Oracle software and databases through standard file 
organization

■ Greater reliability through data spanning multiple physical drives

■ Higher performance through decreased I/O contention for disks

For example, Oracle Universal Installer now separates Oracle software executables 
from database files. Previously, database files were placed in ORACLE_
HOME\database, a subdirectory of the Oracle home directory that also contained 
Oracle software.

Using OFA, Oracle Universal Installer puts Oracle software in ORACLE_
BASE\ORACLE_HOME and database files in ORACLE_BASE\oradata. Now when 
you upgrade a database to the latest release, the new Oracle software executables 
will be placed in a different Oracle home directory. After you judge the upgrade 
successful, you can easily remove the old Oracle home directory and reclaim space, 
because the database does not reside there.

Benefits of an OFA-Compliant Database
An OFA-compliant database has the following benefits:

■ Easier database administration and management of database growth

The file system organization simplifies locating specific database files and 
adding database files as the database grows.

■ Fewer performance bottlenecks

Disk contention decreases, because Oracle administration files, binary files, and 
datafiles that used to be on one disk can now reside in separate directories on 
separate disks.

■ Safeguards against disk failures

By spreading files across more than one disk, disk failures impact as little data 
as possible.

■ Support for concurrent execution of application software

Multiple releases of application software can run simultaneously, enabling 
testing and use of a new release of an application before abandoning the 
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previous release. Transferring to a new release after an upgrade is simple for the 
database administrator and transparent for the user.

Characteristics of an OFA-Compliant Database
An OFA-compliant database has the following characteristics:

■ Independent subdirectories

Categories of files are separated into independent subdirectories so that files in 
one category are minimally affected by operations on files in other categories.

■ Consistent naming conventions for database files

Database files are easily distinguishable from all other files. Files of one 
database are easily distinguishable from files of another database. Datafiles, 
redo log files, and control files are easily identifiable. Datafiles are clearly 
associated with a particular tablespace.

■ Integrity of Oracle home directories

You can add, move, or delete Oracle home directories without having to revise 
applications that refer to them.

■ Separation of administrative information for each database

The ability to distinguish administrative information about one database from 
that of another ensures a reasonable structure for the organization and storage 
of administrative data.

■ Separation of tablespace contents

Tablespace free space fragmentation and I/O request contention are minimized, 
while administrative flexibility is maximized.

■ Tuning I/O loads across all disks

I/O loads are tuned across all disks, including disks storing Oracle data in raw 
devices, if needed.
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Differences Between Directory Trees by Release
OFA has necessitated changes to the Oracle database directory tree. This section 
lists the differences.

Top-Level Oracle Directory
When you install an Oracle8i Release 8.1.3 or earlier release, all subdirectories are 
located under a top-level ORACLE_HOME directory that by default is C:\orawin95.

When you install an Oracle8i Release 8.1.4 or later OFA-compliant database, all 
subdirectories are no longer under a top-level ORACLE_HOME directory. There is 
now a new top-level directory called ORACLE_BASE that is of the form 
X:\oracle where X is any hard drive. If you install an OFA-compliant database 
using Oracle Universal Installer defaults, then ORACLE_BASE is C:\oracle.

ORACLE_BASE contains \ORACLE_HOME directories, \oradata directories (for 
database files), and \admin directories (for database administration files).

Database Filenames
In Oracle8i Release 8.1.3 and earlier releases, database files have the SID in the 
database filename. For example, the first control file is named ctl1SID.ora.

Beginning with Oracle8i Release 8.1.4, database files no longer have the SID in the 
database filename. For example, the first control file is named control01.ctl. 
There is no need for the presence of the SID in the filename, because all the database 
files for a particular database are placed in \oradata under a directory called DB_
NAME that is named for that database.

Database Filename Extensions
In Oracle8i Release 8.1.3 and earlier releases, all database files have the same .ORA 
extension.

In an OFA-compliant release, the convention of having .ora as the filename 
extension for database files is no longer used. Database filenames now have more 
meaningful extensions. These are: 

■ .ctl for control files

■ .log for log files

■ .dbf for datafiles
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OFA Directory Naming Conventions
OFA uses directory naming conventions that make it easy to identify the precise 
Oracle home and database name that is associated with a set of files. This section 
describes the naming conventions used for the top-level directories of an 
OFA-compliant database directory tree:

■ ORACLE_BASE Directory

■ ORACLE_HOME Directory

■ ADMIN Directory

■ ORADATA Directory

■ DB_NAME Directory

ORACLE_BASE Directory
ORACLE_BASE is the root of the Oracle directory tree. If you install an 
OFA-compliant database using Oracle Universal Installer defaults, then ORACLE_
BASE is X:\oracle where X is any hard drive. For example, C:\oracle.

If you are installing Oracle9i for Windows on a computer with no other Oracle 
software installed, then you can change ORACLE_BASE before running Oracle 
Universal Installer. Most users will not need or want to do this.

Do not change the value of ORACLE_BASE after you run Oracle Universal Installer 
for the first time. If there is an existing ORACLE_BASE and you change it, then there 
will be a conflict of Oracle base directories. If you create another ORACLE_BASE 
when the original ORACLE_BASE already exists, then certain tools and the database 
will not be able to find previously created files. They will look for them in the new 
ORACLE_BASE instead of the original ORACLE_BASE.

Changing ORACLE_BASE at the System Level on Windows 95 or 98:
1. Open the autoexec.bat file, using a text editor.

2. Edit the value of the ORACLE_BASE statement.

3. Restart your computer.

Note: An ORACLE_BASE registry key exists for every Oracle 
home. Ideally, the value of the ORACLE_BASE registry key will be 
identical for each Oracle home.
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ORACLE_HOME Directory
The \ORACLE_HOME directory is located beneath X:\ORACLE_BASE and contains 
subdirectories for Oracle software executables and network files.

If you install Oracle9i Personal Edition for Windows 98 on a computer with no 
other Oracle software installed and you use the default settings, then the first Oracle 
home directory that you create is called \ora90.

ADMIN Directory
Database administration files are stored in subdirectories of ORACLE_BASE 
\admin\DB_NAME. The names and brief descriptions of some of these 
subdirectories are:

\bdump     --background process trace files
\cdump     --core dump files
\create    --database creation files
\exp       --database export files
\pfile     --initialization parameter files
\udump     --user SQL trace files
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ORADATA Directory
Database files are stored in ORACLE_BASE\ORADATA\DB_NAME. The names and 
brief descriptions of these files are:

control01.ctl   --control file 1
control02.ctl   --control file 2
control02.ctl   --control file 3
oemrep03.dbf    --Oracle Enterprise Manager repository tablespace datafile
system01.dbf    --SYSTEM tablespace datafile
rbs01.dbf       --RBS tablespace datafile
indx01.dbf      --INDX tablespace datafile
temp01.dbf      --TEMP tablespace datafile
users01.dbf     --USERS tablespace datafile
redo01.log      --redo log file group one, member one
redo02.log      --redo log file group two, member one
redo03.log      --redo log file group three, member one

DB_NAME Directory
DB_NAME is the unique name for a particular database and has the same value as 
the DB_NAME parameter in the initialization parameter file (init.ora). When you 
create a database, DB_NAME can be no more than eight characters long and can 
contain only the following characters:

■ Alphabetic characters

■ Numbers

■ Underscores (_)

■ Pound sign (#)

■ Dollar sign ($)

OFA and Multiple Oracle Home Configurations
The following sections describe various OFA and multiple Oracle homes 
configurations.

Note: This directory structure allows for disk striping only on 
UNIX platforms.
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Specifying an ORACLE_HOME Directory
To install an OFA-compliant database, you must specify an Oracle home directory 
in the Path: field of Oracle Universal Installer. It is of the form:

X:\[PATHNAME]\oracle\HOME_NAME

where:

■ X:\ is any hard drive. For example, C:\

■ [PATHNAME] is an optional directory path name

■ \oracle is a mandatory directory path name, unless you changed the value of 
the ORACLE_BASE registry key before performing the installation

■ HOME_NAME is the name of the Oracle home

The following are examples of OFA-compliant Oracle home directories:

■ C:\test\oracle\ora90

■ D:\oracle\ora90

Installing a Default OFA Database: Example
1. Install Oracle9i Personal Edition for Windows 98, Release 1 (9.0.1.1.0) on a 

computer with no other Oracle software installed and accept the default Oracle 
Universal Installer settings for the first Oracle home (C:\oracle\ora81) in 
the path: field.

2. Complete the installation.

3. Run Oracle Universal Installer again and install Oracle9i Release 1 (9.0.1.1.0). 
Accept the default Oracle Universal Installer settings for the first Oracle home 
(C:\oracle\ora90) in the Path: field.

Table 5–3 describes the default OFA database settings.

Table 5–3 Default OFA Database Settings

Setting Value

ORACLE_BASE C:\oracle (the same for all Oracle homes)

Oracle home 1 C:\oracle\ora81

Oracle home 2 C:\oracle\ora90
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Installing a Nondefault OFA Database: Example 1
1. Install Oracle9i Personal Edition for Windows 98, Release 1 (9.0.1.1.0) and 

change the default Oracle Universal Installer settings for the first Oracle home 
from C:\oracle\ora90 in the path: field to X:\xyz.

2. Complete the installation.

3. Run Oracle Universal Installer again and change the default Oracle Universal 
Installer settings for the second Oracle home from C:\oracle\ora90 in the 
Path: field to Y:\abc.

Table 5–4 shows the nondefault OFA database settings for example 1.

The resulting directory tree would like like this:

X:\xyz
     \admin
          \DB_NAME1
          \DB_NAME2
     \bin
     \network
     \oradata
          \DB_NAME1
               control01.ctl
               control02.ctl
               control03.ctl
               indx01.dbf
               rbs01.dbf
               system01.dbf
               temp01.dbf
               users01.dbf
               redo01.log
               redo02.log
               redo03.log
          \DB_NAME2

Table 5–4 Nondefault OFA Database Settings: Example 1

Setting Value

ORACLE_BASE X:\xyz for the first Oracle home; 
Y:\abc for the second Oracle home

Oracle home 1 X:\xyz

Oracle home 2 Y:\abc
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 Y:abc
     \admin
          \DB_NAME1
          \DB_NAME2
     \bin
     \network
     \oradata
          \DB_NAME1
               control01.ctl
               control02.ctl
               control03.ctl
               indx01.dbf
               rbs01.dbf
               system01.dbf
               temp01.dbf
               users01.dbf
               redo01.log
               redo02.log
               redo03.log
          \DB_NAME2

Installing a Nondefault OFA Database: Example 2
1. Install Oracle9i Personal Edition, Release 1 (9.0.1.1.0) and change the default 

Oracle Universal Installer settings for the first Oracle home from 
C:\oracle\ora90 in the Path: field to X:\xyz\oracle\abc.

2. Complete the installation.

3. Run Oracle Universal Installer again and change the default Oracle Universal 
Installer settings for the second Oracle home from C:\oracle\ora90 to 
X:\pqr.

Table 5–5 shows the nondefault OFA database settings for example 2.

Table 5–5 Nondefault OFA Database Settings: Example 2

Setting Value

ORACLE_BASE X:\xyz\oracle 

(same for both Oracle homes)

Oracle home 1 X:\xyz\oracle\abc

Oracle home 2 X:\pqr
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The resulting directory tree would look similar to this:

X:\pqr                             --Oracle home 2
     \bin
     \network
X:\xyz
     \oracle                       --ORACLE_BASE for both Oracle homes
          \abc                     --Oracle home 1
               \bin
               \network
          \admin
               \db_name1
                    \adhoc
                    \bdump
                    \cdump
                    \create
                    \exp
                    \pfile
                    \udump
               \DB_NAME2
                    \...
          \oradata
               \DB_NAME1
                    control01.ctl
                    control02.ctl
                    control03.ctl
                    indx01.dbf
                    rbs01.dbf
                    system01.dbf
                    temp01.dbf
                    users01.dbf
                    redo01.log
                    redo02.log
                    redo03.log
               \DB_NAME2
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6
Oracle9i Default Accounts and Passwords

This chapter describes the Oracle9i Personal Edition default accounts and 
passwords.

This chapter contains these topics:

■ Overview

■ Unlocking and Changing Passwords

■ Granting Limited SYS Database Role Privileges

■ Reviewing Accounts and Passwords
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Overview
Oracle9i Personal Edition installs with a number of default accounts. The Oracle 
Database Configuration Assistant locks and expires all default database accounts 
upon successful installation with the following exceptions:

■ SYS

■ SYSTEM

■ SCOTT

■ DBSNMP

■ OUTLN

■ AURORA$ORB$UNAUTHENTICATED

■ AURORA$JIS$UTILITY$

■ OSE$HTTP$ADMIN

You must unlock all other accounts before using them. Oracle Corporation 
recommends changing all user passwords immediately after installation. 

At a minimum, the Oracle Database Configuration Assistant creates the SYS, 
SYSTEM, and DBSNMP accounts in all databases. Additional accounts are created 
depending on the components installed. Unlock accounts and change passwords 
before using them. Table 6–2 describes the accounts and passwords.

Important: If installing Oracle Internet Directory, then change 
the passwords for SYS and SYSTEM only after the Oracle Internet 
Directory installation is complete.

See Also:

■ Oracle9i Personal Edition Administrator’s Guide for Windows 98 for 
information on Oracle security procedures and security best 
practices
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Unlocking and Changing Passwords
At the end of installation, several configuration assistants automatically start to 
create and configure your database and network environments. One such assistant 
is the Oracle Database Configuration Assistant, which automatically prompts you 
to change passwords and unlock accounts immediately after installation.

To change a password during the database installation and configuration process:

1. From the Oracle Database Configuration Assistant window, choose the 
Password Management button.

2. Select a username and clear the check mark.

3. Enter a new password and confirm the new password for each username. 

Alternatively, use SQL*Plus to unlock accounts and change passwords any time 
after the installation process.

To change a password after installation:

1. Start SQL*Plus:

C:\> SQLPLUS /NOLOG

2. Connect as SYSDBA:

SQL> CONNECT SYS/PASSWORD AS SYSDBA

3. Change the password according to the SQL commands indicated in Table 6–1.

Note: The Password Management button is not available when 
using Oracle Database Configuration Assistant as a standalone tool 
(that is, after the installation and configuration process is complete).

Note: If you unlock a password, but do not specify a new 
password, then the password is expired until the next time you 
access that account. 
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Granting Limited SYS Database Role Privileges
Any database user can be granted a limited SYS database role privilege to use the 
Oracle Enterprise Manager Diagnostic Pack. Grant users access to these necessary 
SYS privileges by granting the OEM_MONITOR role. This role is created when the 
database is installed and is defined in the SQL script at \ORACLE_BASE\ORACLE_
HOME\rdbms\admin\catsnmp.sql.

Reviewing Accounts and Passwords
Table 6–2 lists Oracle9i default accounts and passwords. It also briefly describes the 
purpose of each username and shows where to find additional information.

Table 6–1 SQL Statements for Administering Accounts and Passwords

Action SQL Statement

Unlock a password ALTER USER username ACCOUNT UNLOCK;

Lock a password ALTER USER username ACCOUNT LOCK;

Change the password of an unlocked 
account

ALTER USER username IDENTIFIED BY 
password;

Change the password of a locked 
account

ALTER USER username ACCOUNT IDENTIFIED 
BY password ACCOUNT UNLOCK;

See Also: Oracle9i SQL Reference for information on the GRANT 
statement

Table 6–2 Oracle9i Default Accounts and Passwords

Username Password Description More Information

SYSTEM1 MANAGER Used for performing database administration 
tasks. SYSTEM includes the AQ_
ADMINISTRATOR_ROLE and DBA database 
roles.

Oracle9i Database 
Administrator’s Guide

SYS2 CHANGE_ON_ 

INSTALL3
Used for performing database administration 
tasks.

Oracle9i Database 
Administrator’s Guide

AURORA$JIS$UTIL
ITY$

Randomly 
assigned at 
installation

Used internally by Enterprise Java Beans and 
CORBA Tools. Log on as SYS to change the 
password for this username.

Not applicable
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AURORA$ORB$UNAU
THENTICATED

Randomly 
assigned at 
installation

Used internally by Enterprise Java Beans and 
CORBA Tools. Log on as SYS to change the 
password for this username.

Not applicable

OSE$HTTP$ADMIN Randomly 
assigned at 
installation

Used internally by the Oracle Servlet Engine. 
Log on as SYS to change the password for this 
username.

Not applicable

OUTLN OUTLN Centrally manages metadata associated with 
stored outlines. Supports plan stability, which 
allows you to maintain the same execution 
plans for the same SQL statements. Includes 
CONNECT and RESOURCE database roles.

Oracle9i Database 
Concepts 

Oracle9i Database 
Performance Guide and 
Reference

SCOTT TIGER Includes CONNECT and RESOURCE database 
roles.

Oracle9i Personal 
Edition Database 
Administrator’s Guide 
for Windows 98

1 If installing Oracle Internet Directory, then change the passwords for SYS and SYSTEM only after the Oracle Internet 
Directory installation is complete.

2 If installing Oracle Internet Directory, then change the passwords for SYS and SYSTEM only after the Oracle Internet 
Directory installation is complete. SYS includes the following database roles: AQ_ADMINISTRATOR_ROLE, AQ_USER_
ROLE, CONNECT, CTXAPP, DBA, DELETE_CATALOG_ROLE, EXECUTE_CATALOG_ROLE, EXP_FULL_DATABASE, HS_
ADMIN_ROLE, IMP_FULL_DATABASE, JAVA_ADMIN, JAVADEBUGPRIV, JAVA_DEPLOY, JAVAIDPRIV, 
JAVAUSERPRIV, JAVASYSPRIV, OEM_MONITOR, OLAP_DBA, RECOVERY_CATALOG_OWNER, RESOURCE, SELECT_
CATALOG_ROLE, WKADMIN, WKUSER, and WM_ADMIN_ROLE.

3 SQL statement must include the privilege AS SYSDBA or AS SYSOPER.

See Also:

■ "The Oracle Database Administrator" in Oracle9i Database 
Administrator’s Guide

■ "Administering External Users and Roles" in Oracle9i Network, 
Directory, and Security Guide for Windows

Table 6–2 (Cont.) Oracle9i Default Accounts and Passwords

Username Password Description More Information
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7
Configuration Parameters and the Registry

This chapter describes the use of the registry for various components. It also lists 
the recommended values and ranges for configuration parameters.

This chapter contains these topics:

■ About Configuration Parameters

■ Registry Overview

■ Registry Parameters

■ Adding a Registry Parameter with REGEDIT

■ Adding or Modifying Initialization File Parameters and Registry Parameters 
with Oracle9i Navigator’s “Parameter Configurer”
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About Configuration Parameters
Oracle9i Personal Edition for Windows 98 uses configuration parameters to locate 
files and specify runtime parameters common to all Oracle products. When an 
Oracle program or application requires a translation for a particular configuration 
variable, Oracle9i Personal Edition for Windows 98 uses the associated parameter. 
All Oracle parameters are stored in the registry

Registry Overview
Oracle9i Personal Edition for Windows 98 stores its configuration information in a 
repository (the registry) that is organized in a tree format. The tree format consists 
of keys in the registry and parameter values for the keys. Keys and parameter 
values can be viewed and modified in the Registry Editor.

Keys are folders that appear in the left pane of a Registry Editor window. A key 
contains subkeys or parameters.

Parameters in the Registry Editor appear as a string, consisting of two components:

■ Parameter name

■ Value itself

For example, parameter ORACLE_SID can have the following entry in the registry:

ORACLE_SID:orcl1

Most Oracle9i Personal Edition for Windows 98 parameter values are string types. 
Use Oracle Universal Installer defaults when a type is not given.

WARNING: Although the Registry Editor lets you view and 
modify registry keys and parameter values, you normally are not 
required to do so. In fact, you can render your system useless if 
you make incorrect changes. Therefore, only advanced users 
should edit the registry! Back up your system before making any 
changes in the registry.
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Registry Parameters
This section describes the Oracle9i Personal Edition for Windows 98 registry 
parameters for the following keys. Other products, such as Oracle Enterprise 
Manager, have additional keys and parameters that are not described in this 
chapter. 

■ HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID

■ HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE

■ HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ALL_HOMES

To modify these registry values, see "Modifying a Registry Value with REGEDIT" on 
page 7-7 in this manual.

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID
Each time you install Oracle products into a new Oracle home on your computer, 
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID is created and ID is 
incremented. This subkey contains parameter values for most Oracle products.

This figure shows the parameter subkeys created with two Oracle home directories 
on the same computer.

Note: This chapter describes how to use REGEDIT to edit your 
registry. 

Additional Information: See Chapter 5, "Multiple Oracle Homes 
and Optimal Flexible Architecture" for details on the PATH variable 
and registry values when you are working with multiple Oracle 
homes.
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The first Oracle installation 
on a computer creates 
parameter subkey HOME0.

The second installation of a “Multiple Oracle 
Homes” enabled product (e.g. SQL*Plus) on a 
computer creates parameter subkey HOME1. 
With each installation into a new Oracle home, 
HOMEID is created and incremented.
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HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID includes the 
following parameters for an Oracle home directory on a computer.

 

Parameter Description Default Value

MSHELP_TOOLS   Specifies the location of the Windows help files. ORACLE_BASE\ORACLE_
HOME\MSHELP

NLS_LANG   Specifies the supported language, territory, and 
character set. This parameter specifies the 
language in which the messages are displayed, the 
territory and its conventions for calculating week 
and day numbers, and the character set displayed.

During installation, Oracle 
Universal Installer sets this value 
based on the language setting of 
the operating system. See Oracle9i 
Installation Guide for Windows 98 for 
a list of commonly used values.

Note: If this parameter is deleted at 
a later time, Oracle uses the value 
AMERICAN_
AMERICA.US7ASCII.

ORA_CWD   Specifies the current working directory. This 
parameter must be manually set. 

The value for this parameter must 
be set manually.

ORA_SID_PFILE   The full path to the initialization parameter file. ORACLE_BASE\ADMIN\DB_
NAME\PFILE\INIT.ORA

ORACLE_BASE   The top-level Oracle directory (for example, 
C:\ORACLE) that contains ORACLE_HOME, 
\ADMIN, and \ORADATA.

ORACLE_BASE

ORACLE_GROUP_
NAME   

Specifies the name of the group containing icons of 
the Oracle products installed. The parameter is 
added to your registry when you first install 
Oracle products, even if Oracle Universal Installer 
does not create a program group for the Oracle 
products you have installed (for example, if you 
have installed only Net software).

Oracle - HOME_NAME

ORACLE_HOME   Specifies the Oracle home directory in which 
Oracle products are installed. This directory is 
immediately beneath the Oracle base directory in 
the Oracle directory hierarchy. 

The drive letter and name that you 
specify during installation

ORACLE_HOME_
KEY   

The HKEY_LOCAL_MACHINE location of Oracle 
parameters.

SOFTWARE\ORACLE\HOMEID

ORACLE_HOME_ 
NAME   

Specifies the home name of the Oracle home 
directory in which Oracle products are installed. 

The name that you specify during 
installation
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HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE
The subkey contains the following parameters:

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ALL_HOMES
The subkey provides general information on each Oracle home directory on a 
computer. This subkey contains the IDx subkey(s) and its parameters, described 
below, as well as other parameters listed on page 7-7.

NAV90 Specifies Oracle9i Navigator files ORACLE_BASE\ORACLE_
HOME\NAV90

PO8 Specifies that the Oracle9i Navigator be used YES

DATABASE_
STARTUP

Specifies whether the database should be 
mounted, if not started and mounted already, 
when connected using Server Manager/ 
SQL*Plus/ Oracle9i Navigator

AUTO

(If it is set to NOAUTO, database 
will not be mounted even if not 
already mounted when connected 
using Server Manager/ 
SQL*Plus/Oracle9i Navigator)

ORACLE_SID   Specifies the name of the Oracle database instance 
on the host machine. The value of this parameter is 
the SID for the instance.

The default value is specified by 
the entry in the Database 
Identification window of Oracle 
Universal Installer.

RDBMS_
ARCHIVE 

Specifies the location of the backup database files. ORACLE_BASE\ORACLE_
HOME\DATABASE
\ARCHIVE

RDBMS_
CONTROL 

Specifies the location of the backup database 
control files.

ORACLE_BASE\ORACLE_
HOME\DATABASE

SQLPATH Specifies the location of SQL scripts. ORACLE_BASE\ORACLE_
HOME\DBS

Parameter Description Default Value Entry

INST_LOC Specifies the location of Oracle Universal Installer 
files.

System Drive:\Program 
Files\Oracle\Inventory

OO4O Specifies the location of Oracle Objects for OLE 
message files.

ORACLE_BASE\ORACLE_
HOME\OO4O\MESG

Parameter Description Default Value
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IDx
This subkey corresponds to the HOMEID of the same number (for example, 
HOME0 for the first installation, HOME1 for the second installation, and so on). IDx 
contains the following parameters. The values that display are determined by what 
you enter during installation in the File Locations dialog box of Oracle Universal 
Installer.

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ALL_HOMES Parameters
The subkey contains the following parameters.

Modifying a Registry Value with REGEDIT

To edit the Oracle-related settings:

1. Start the registry in one of two ways:

Parameter Description Default Value Entry

NAME Specifies the home name of the Oracle home for 
IDx. This is the value that you specify when 
prompted for an Oracle home name.

The name that you specify during 
installation.

PATH   Specifies the Oracle home directory for IDx. ORACLE_BASE\ORACLE_HOME

Parameter Description Default Value

DEFAULT_HOME Specifies the default Oracle home name (that is, the 
first Oracle home installed on your machine).

The name that you specify during 
installation.

HOME_COUNTER Specifies the number of installed Oracle homes. 1

LAST_HOME Displays the ID number of the most recently 
installed Oracle home. For example, if HOME0 was 
the most recently installed Oracle home, the 
number 0 appears.

0

CAUTION: Do not edit your registry unless absolutely necessary. 
If an error occurs in your registry, Oracle9i Personal Edition for 
Windows 98 can stop functioning and the registry itself can 
become unusable.
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■ From the command prompt, enter:

C:\> REGEDIT
■ Choose Start >Run, enter REGEDIT in the Open field, and click OK.

The Registry Editor window appears.

2. Navigate to the values you want to view or modify by double-clicking the 
appropriate keys.

The left-hand side of the window shows the hierarchy of registry keys, and the 
right-hand side of the window shows various values associated with a key.

3. Double-click the parameter to edit.

The String Editor dialog box appears:
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4. Make the necessary edits.

5. Choose OK.

6. Choose Exit from the Registry menu

Adding a Registry Parameter with REGEDIT
To add a parameter to the registry:

1. Start the registry in one of two ways:

■ From the MS-DOS command prompt, enter:

C:\> REGEDIT
■ Choose Start > Run, enter REGEDIT in the Open field, and click OK.

The Registry Editor window appears.



Adding a Registry Parameter with REGEDIT

7-10 Oracle9i Personal Edition Getting Started

2. Navigate to the key to which you want to add the new value.

3. Choose New-> String Value from the Edit menu. You can select either of the 
following three types of values

■ String Value

■ Binary Value

■ DWORD Value (hexadecimal data)

4. Type the name that you want to assign to the currently created values for the 
selected key.

5. To enter the data, select the ‘Value’ then select ‘Modify’ from ‘Edit’ menu. 

A Edit dialog box appropriate for the data type appears:
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6. Type the value for the parameter.

7. Choose OK.

The Registry Editor adds the parameter. 

8. Choose Exit from the Registry menu.

The registry exits.

Adding or Modifying Initialization File Parameters and Registry 
Parameters with Oracle9i Navigator’s “Parameter Configurer”

Oracle9i Navigator has been enhanced with the capability of modifying database 
initialization parameter files and registry parameters. The following sections 
describe this new feature in detail. 

Introducing Database Parameter Configuration Assistant
Database Parameter Configuration Assistant provides an easy to use interface to 
manipulate the parameters in the database initialization files (for example, 
init.ora file). These parameters are also called the Database Initialization 
Parameters. It also provides a user interface for safe manipulation of the registry 
parameters used by the Oracle9i Database Server. These parameters in the registry 
are called Oracle9i Configuration Parameters.

Introduction to Manipulating Database Initialization Parameters
The Initialization Parameter file is a text file that contains a list of parameters and a 
value for each parameter. The name of the parameter file varies depending on the 
operating system. For example, it can be in mixed case or lowercase, or it can have a 
logical name or a variation of the name init.ora.
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Database administrators can use initialization parameters to: 

■ Optimize performance by adjusting memory structures, such as the number of 
database buffers in memory

■ Set some database-wide defaults, such as the amount of space initially allocated 
for a context area when it is created 

■ Set database limits, such as the maximum number of database users 

■ Specify names of files

For more details on the Initialization Parameter file and individual parameters in 
this file refer to the Oracle9i Reference documentation available under Oracle9i 
Server in the documentation accompanying the CD.

On opening an already existing database initialization file, you will see a list of 
parameters present in that file and all the files included therein as shown in the 
following figure:
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Opening a window to manipulate database initialization files
1. Click on menu option View.

2. Under the Parameter Configuration menu option, a menu will pop up

3. Click on the initialization file and a window to manipulate the database 
parameters will be opened.

Creating a new initialization file
1. Click on menu File > New

2. A file dialogue will pop up. Choose the file into which the parameters have to 
be saved.

3. Start adding parameters.

4. After you are done, save the file.

Note: 1. The parameters specified in the initialization 
files are used by the database to initialize 
itself when starting up. Hence any changes 
that you make to this file will take effect only 
after you restart the database.

2. Alter Session and Alter System commands 
are not supported by the Parameter 
Configuration Assistant.

3. The Parameter Configuration Assistant will 
not list parameters whose value is dependent 
on other parameters. 

4. The system will maintain a backup of 
initialization file being modified. For 
example, if you are modifying a file init.ora in 
the directory 
c:\oracle\ora90\database, then a 
backup of the file named as 
init.ora.<timestamp> in the same 
directory location will be kept.
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To open an already existing parameter file
1. Click on menu File > open

2. From the popped up file dialogue, choose the parameter file to open.

3. If the parameter file is successfully opened, then you should see the list of 
parameters and their values on the window.

To add a parameter
1. Before adding a parameter, you should either have opened an already existing 

parameter file or created a new parameter file.

2. Click on menu Edit > Add or right-click in the window and select Add from the 
menu.

3. A dialogue box will pop up containing the following fields.

 

4. Select the parameter you want to add from the available list present against 
Name.

5. Enter the value of the parameter in the Value field. (The range of the chosen 
parameter is shown in the Range field. The Range field is not editable.)

6. In Save in File field, you will see a filename where the parameter will be saved. 
This filename will be same as the filename you provided while creating a new 
parameter file or opening an already existing file. In case you want to organize 
the parameters across many files and include the files from one file using IFILE 
parameter, change the Save in File to a suitable file name.

7. Choose OK to reflect the change on the window, choose Cancel to discard the 
change.

Name The name of the parameter.

Value The value of that parameter.

Range The valid range of the parameter, if 
any. 

Save in File The file in which the parameter has to 
be saved.
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Deleting a Parameter
1. Click on the parameter to be deleted.

2. Click Edit > Delete or right click on the parameter to be deleted and select 
Delete from the menu.

Modifying a Parameter Value
1. Double-Click on the parameter to be modified or right click on the parameter to 

be modified and select Modify from the menu.

2. Change the value of the parameter in the Dialogue box that appears.

3. Choose OK to reflect the change on the window, choose Cancel to discard the 
change.

Note: For using parameter IFILE, to include an initialization file in 
a nested initialization file, you should also specify the filename in 
which the value of the ifile has to be placed. 

For example, if you have a init1.ora file including init2.ora file 
which in turn includes init3.ora file, then the GUI will show the 
value for the parameter IFILE as: 

init1.ora::init2.ora, init2.ora::init3.ora. 
init1.ora 
  |
  +----> init2.ora 
           |
           +-----> init3.ora

If you want to include another file init4.ora into init2.ora, 
the value of IFILE shown in the GUI has to be modified to:

init1.ora::init2.ora, init2.ora::init3.ora, 
init2.ora::init4.ora.  

Now the structure of the files included will be:

init1.ora 
  |
  +----> init2.ora 
           |
           +-----> init3.ora
           +-----> init4.ora
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Saving the parameters
Click on Menu File > Save.

The parameters will be saved into the files that appears in the “Save in File” field of 
the respective parameters.

Introduction to Manipulating Oracle9i Configuration Parameters
Oracle9i Personal Edition uses configuration parameters to locate files and specify 
run time parameters common to all Oracle products. All Oracle parameters are 
stored in the registry. Database Parameter Configuration Assistant provides a user 
interface for safe manipulation of the registry parameters used by the Oracle9i 
Database Server.   

The following is a short description of the window used to modify the 
configuration parameters.
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1. On opening a window to manipulate the Oracle9i configuration parameters 
(and if you have Oracle Server installed in any of the Oracle Home locations), 
you will see a tree of Oracle Homes in the left window.

2. Each Oracle Home has a list of predefined number of SID-independent 
parameters i.e., the parameters that are common to all SIDs like DBA_
AUTHORIZATION, DATABASE_STARTUP etc., and a list of SIDs belonging to 
that Home.

3. Each SID has a list of predefined number of SID-specific parameters i.e., 
parameters that are specific for different SIDs like ORA_SID_PFILE, ORA_SID_
PWFILE.

4. On expanding each of the Oracle Home that appears in the tree, you will see 
two folders, one for SID-independent parameters; another for SID specific 
parameters.
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5. On expanding the SID-Independent Parameters folder, you will see the list of 
SID-independent parameters and their corresponding values for that Oracle 
Home in the right window.

6. On expanding the SID List folder, you will see a list of available SIDs under that 
Home. Clicking on any of the SID folders will show a list of SID specific 
parameters and their corresponding values in the right window.

Opening a window to manipulate configuration parameters
1. Click on menu option View.

2. Under the Parameter Configuration menu option, a menu will pop up.

3. Click on the Configuration Parameters and a window to manipulate the registry 
parameters will pop up.

Modifying a parameter value
1. By clicking on the appropriate tree elements in the left window, have the 

parameter -- that needs to be changed -- to appear in the right window. 

2. For example, if you want to change the ORA_ORCL_PFILE parameter for SID = 
ORCL in Home_0, then expand Home_0, expand SID List that is present under 
Home_0, click on ORCL, that should appear on the left window on expanding 

Note:

1. You will see a tree of installed Oracle Homes in the left window. 

2. Each Oracle Home has a list of predefined number of SID-independent 
parameters and a list of SIDs belonging to that Home.

3. Each SID has a list of predefined number of SID specific parameters.

4. On expanding each of the Oracle Home that appears in the tree, you 
will see two folders, SID Independent and SID List.

5. On expanding the SID Independent folder, you will see the list of SID 
independent parameters and their corresponding values for that 
Oracle Home in the right window.

6. On expanding the SID List folder, you will see a list of available SIDs 
under that Home.

7. Clicking on any of the SID folders will show a list of SID specific 
parameters and their corresponding values in the right window.
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the SID List. You should see the parameter ORA_ORCL_PFILE on the right 
window.

3. Double click on the parameter to be modified or right click on the parameter to 
be modified and select Modify from the menu.

4. A dialogue box will pop up. Enter the new value for the parameter in the 
dialogue box.

5. Choose OK to reflect the change, choose Cancel to discard the change.

Deleting a particular parameter
The parameters cannot be deleted. If you want to avoid writing the parameter into 
the registry then modify the parameter and make that parameter value as NULL.

For example, to delete ORA_ORCL_PFILE for the SID ORCL, modify ORA_ORCL_
PFILE and clear the string that appears on the modify dialogue box and click on 
OK. You should see a "" against the value for ORA_ORCL_PFILE after this 
modification. Or right click on the parameter you want to delete and select Clear.

Note: For saving the registry parameter value changes, Click on 
menu File -> Save.

To reload the parameter values from the registry, Click on menu 
View -> Refresh.
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8
Developing Applications for Windows

This chapter points to sources of information on developing applications for 
Windows and outlines a procedure for building and debugging external 
procedures.

This chapter contains these topics:

■ Finding Information on Application Development for Windows 98

■ Building External Procedures

■ Accessing Web Data with Intercartridge Exchange 
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Finding Information on Application Development for Windows 98
This section describes where to find information on developing applications 
specifically for Windows. These products are included on your Oracle Server 
CD-ROM.

Java Enhancements
Oracle9i includes many Java enhancements. JVM includes the integrated Java 
Virtual Machine, JServer Accelerator, and Oracle Servlet Engine. Oracle also 
provides Oracle Java Database Connectivity (JDBC) Drivers. For more information:

■ Oracle9i Java Developer’s Guide 

■ Oracle9i Servlet Engine Developer’s Guide and the entire Java documentation set

XML Support
Oracle's XML products include the XML Developer’s Kit (XDK) and Oracle XML 
SQL Utility. For more information:

■ Oracle9i Application Developer’s Guide - XML 

■ Oracle9i XML Reference 
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Application Wizards
Oracle Application Wizards allow developers to create database applications easily 
and quickly. They improve ease-of-use and reduce development time by generating 
much of the code for database connectivity. For information and downloads:

■ http://technet.oracle.com/software/ 

Oracle COM/COM+ Integration Feature
Oracle’s COM/COM+ integration feature enables Java stored procedure developers 
and COM/COM+ developers to load COM+ objects from the Oracle9i database. For 
more information:

■ Oracle COM Automation Feature Developer’s Guide

■ Oracle Objects for OLE (OO4O) for Windows online help

OLE DB
■ Oracle Provider for OLE DB Developer’s Guide 

Developing Windows Applications
Oracle provides a comprehensive set of APIs for Windows application developers 
and is well suited for both Java and COM/COM+ development. Oracle is 
integrated with Microsoft’s development and deployment components, known as 
the Windows Distributed interNet Applications Architecture (DNA). Performance 
and data access on Windows is enhanced in the following areas:

■ Wide variety of data access methods for Windows and internet applications

■ Wizards and assistants to speed application development

■ COM/COM+/DCOM integration through two APIs: Oracle Objects for OLE or 
Oracle Provider for OLE DB

Note: Oracle ODBC Driver is updated on a regular basis. Release 
9.0 is included on your CD-ROM. To download the latest release, 
visit: http://technet.oracle.com/software/ 

Select Oracle ODBC Drivers from the “Select a Utility or Driver” 
drop-down list.
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■ Microsoft Transaction Server integration: Oracle Services for Microsoft 
Transaction Server

■ Platform extensions for internet application development

Developers are able to deploy their database applications more quickly by using the 
data access method with which they are familiar, rather than having to learn a new 
one. An Oracle database server can communicate with Windows clients in a variety 
of methods, as described in Table 8–1.

By using Oracle data access interfaces, developers can take advantage of specific 
Oracle9i features. These interfaces also offer flexibility and adherence to open 
standards. 

Oracle COM/COM+ interfaces include the following features:

■ OO4O can be used from any programming environment that supports 
Microsoft COM/COM+ technology, such as Visual Basic, Visual C++, VBA in 
Excel, Active Server Pages, PowerBuilder, Delphi, Internet Information Server 
(IIS), and Microsoft Transaction Server. OO4O is developed specifically for use 
with Oracle database servers.

■ Oracle Provider for OLE DB gives ActiveX Data Objects (ADO) developers high 
performance and efficient access to Oracle databases. A native OLE DB 
provider, it offers data access optimizations and access to Oracle-specific 
database features.

■ COM/COM+ Automation Feature APIs make it easy for PL/SQL developers to 
incorporate COM/COM+ objects into their routines. A new extension of this 
feature, Oracle COM/COM+ Integration, enables Java stored procedures and 
COM/COM+ developers to load COM/COM+ objects through OLE 
Automation or custom COM/COM+ interfaces from the Oracle9i database. 

Table 8–1 Oracle Data Access Methods

Development 
Environment Data Access Method

Java/CORBA JDBC 

SQLJ 

COM/COM+ Oracle Objects for OLE (OO4O) 

Oracle Provider for OLE DB 

COM/COM+ Automation Feature 
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Building External Procedures
This section describes how to create and use external procedures on Windows. The 
following files are located in ORACLE_BASE\ORACLE_HOME\rdbms\extproc:

■ extern.c Code example shown in "Task 2: Writing an External Procedure"

■ make.bat Batch file that builds the dynamic link library

■ extern.sql Automates the instructions described in "Task 4: Registering an 
External Procedure" and "Task 5: Executing an External Procedure"

External Procedures Overview
External procedures are functions written in a third-generation language (C, for 
example) and callable from within PL/SQL or SQL as if they were a PL/SQL 
routine or function. External procedures let you take advantage of the strengths and 
capabilities of a third-generation programming language in a PL/SQL environment.

The main advantages of external procedures are: 

■ Performance, because some tasks are performed more efficiently in a 
third-generation language than in PL/SQL, which is better suited for SQL 
transaction processing

■ Code re-usability, because dynamic link libraries (DLLs) can be called directly 
from PL/SQL programs on the server or in client tools such as Oracle Forms

Note: Oracle also provides a special purpose interface, the call 
specification, that lets you call external procedures from other 
languages, as long as they are callable by C.
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You can use external procedures to perform specific processes:

■ Solving scientific and engineering problems

■ Analyzing data

■ Controlling real-time devices and processes

To create and use an external procedure, perform the following sequential steps:

■ Task 1: Installing and Configuring

■ Task 2: Writing an External Procedure

■ Task 3: Building a DLL

■ Task 4: Registering an External Procedure

■ Task 5: Executing an External Procedure

Task 1: Installing and Configuring
This section describes the installation and configuration of the Oracle9i database 
and Oracle Net.

Installing the Oracle9i Database
Follow the steps in your Oracle9i Personal Edition Installation Guide for Windows 98 to 
install these products on your Windows server:

■ Oracle9i Personal Edition contains PL/SQL, from which external procedures 
are called, and the PL/SQL external procedure program (EXTPROC), which 
runs external procedures.

■ Oracle Net Client

Note: You must have a C compiler and linker installed on your 
system to build DLLs.

Attention: You can combine the instructions described in the 
fourth and fifth tasks into one SQL script that automates the task of 
registering and executing your external procedure. For an example 
of a SQL script that combines these steps, see

ORACLE_BASE\ORACLE_HOME\rdbms\extproc\extern.sql 
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■ Oracle Net Server

Configuring Oracle Net
If you install Oracle Net Server from your CD-ROM, then your server network files 
are automatically configured to use external procedures. 

When PL/SQL calls an external procedure, the Oracle Net Listener starts a 
session-specific process called EXTPROC. Through Oracle Net, PL/SQL passes the 
following information to EXTPROC:

■ DLL name

■ External procedure name

■ Parameters (if necessary)

EXTPROC then loads the DLL and starts the external procedure.

If you copy your server network files into your Oracle9i network files directory, 
then you must manually configure the following files for the external procedure 
behavior described previously to occur:

■ ORACLE_BASE\ORACLE_HOME\network\admin\listener.ora

■ ORACLE_BASE\ORACLE_HOME\network\admin\tnsnames.ora 

 See the Oracle9i Net Services Administrator’s Guide for instructions.

Task 2: Writing an External Procedure
Using a third-generation programming language, you can write functions to be 
built into DLLs and started by EXTPROC. The following is a simple Microsoft 
Visual C++ example of an external procedure:

Note: The sqlnet.ora file requires no changes. By default, the 
values for the parameters NAMES.DEFAULT_DOMAIN and 
NAME.DEFAULT_ZONE are set to world. These values match with 
the .world extension on the end of EXTPROC_CONNECTION_DATA 
in the tnsnames.ora file.
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#include <windows.h>
#define NullValue -1
/*
  This function tests if x is at least as big as y.
*/
long __declspec(dllexport) find_max(long x, 
 short x_indicator, 
long y, 
short y_indicator, 
 short *ret_indicator)
{
   /* It can be tricky to debug DLL’s that are being called by a process
      that is spawned only when needed, as in this case.  
      Therefore try using the DebugBreak(); command.  
      This will start your debugger.  Uncomment the line with DebugBreak(); 
      in it and you can step right into your code.
   */
   /* DebugBreak();  */

   /* First check to see if you have any nulls. */
   /* Just return a null if either x or y is null. */

   if ( x_indicator==NullValue || y_indicator==NullValue) {
      *ret_indicator = NullValue;   
      return(0);
   } else { 
      *ret_indicator = 0;       /* Signify that return value is not null. */
      if (x >= y) return x;
      else return y;
   }
}

Task 3: Building a DLL
After writing your external procedure(s) in a third-generation programming 
language, use the appropriate compiler and linker to build a DLL, making sure to 

Note: Because external procedures are built into DLLs, they must 
be explicitly exported. In this example, the DLLEXPORT storage 
class modifier exports the function FIND_MAX from a dynamic link 
library.
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export the external procedures as noted previously. See your compiler and linker 
documentation for instructions on building a DLL and exporting its functions. 

After building the DLL, you can move it to any directory on your system. For the 
example in Task 2, you can build the external procedure find_max into a DLL 
called extern.dll by going to ORACLE_BASE\ORACLE_HOME\rdbms\extproc 
and typing make.

Task 4: Registering an External Procedure
Once you have built a DLL containing your external procedure(s), you must register 
your external procedure(s) with the Oracle9i database:

To create a PL/SQL library to map to the DLL:

1. Start SQL*Plus:

C:\> sqlplus

2. Connect to the database with the appropriate username and password.

3. Create the PL/SQL library using the CREATE LIBRARY command:

SQL> CREATE LIBRARY externProcedures AS ’C:\oracle\ora81\rdbms\ 
extproc\extern.dll’;

where externProcedures is an alias library (essentially a schema object in 
the database), and C:\oracle\ora81\rdbms\extproc\extern.dll is the 
path to the Windows operating system dllextern.dll. This example uses 
C:\oracle as your Oracle base and \ora90 as your Oracle home.

4. Create a PL/SQL program unit specification.

Do this by writing a PL/SQL subprogram that uses the EXTERNAL clause 
instead of declarations and a BEGIN...END block. The EXTERNAL clause is the 
interface between PL/SQL and the external procedure. The EXTERNAL clause 
identifies the following information about the external procedure:

■ Name

■ DLL alias

Note: The DBA must grant the EXECUTE privilege on the PL/SQL 
library to users who want to call the library’s external procedure 
from PL/SQL or SQL.
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■ Programming language in which it was written

■ Calling standard (defaults to C if omitted)

In the following example, externProcedures is a DLL alias. You need the 
EXECUTE privilege for this library. The external procedure to call is find_max. 
If enclosed in double quotation marks, it becomes case-sensitive. The 
LANGUAGE term specifies the language in which the external procedure was 
written.

CREATE OR REPLACE FUNCTION PLS_MAX(
  x BINARY_INTEGER,
  y BINARY_INTEGER)
RETURN BINARY_INTEGER AS
  EXTERNAL LIBRARY externProcedures
  NAME "find_max"
  LANGUAGE C
  PARAMETERS (
    x long,                  -- stores value of x
    x_INDICATOR short,       -- used to determine if x is a NULL value
    y long,                  -- stores value of y
    y_INDICATOR short        -- used to determine if y is a NULL value
  RETURN INDICATOR short );  -- need to pass pointer to return value’s
                             -- indicator variable to determine if NULL
-- This means that my function will be defined as:
    -- long max(long x, short x_indicator,
    -- long y, short y_indicator, short * ret_indicator)

Task 5: Executing an External Procedure
To run an external procedure, you must call the PL/SQL program unit (that is, the 
alias for the external function) that registered the external procedure. These calls can 
appear in any of the following:

■ Anonymous blocks

■ Standalone and packaged subprograms

■ Methods of an object type

■ Database triggers

■ SQL statements (calls to packaged functions only)

In "Task 4: Registering an External Procedure", the PL/SQL function PLS_MAX 
registered the external procedure find_max. Follow these steps to run find_max:
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1. Call the PL/SQL function PLS_MAX from a PL/SQL routine named UseIt:

SET SERVER OUTPUT ON
CREATE OR REPLACE PROCEDURE UseIt AS
         a integer;
         b integer;
         c integer;
BEGIN
         a := 1;
         b := 2;
         c := PLS_MAX(a,b);
         dbms_output.put_line(’The maximum of ’||a||’ and ’||b||’ is  ’||c);
END;

2. Run the routine:

SQL> EXECUTE UseIt;

Debugging External Procedures
Usually, when an external procedure fails, its C prototype is faulty. That is, the 
prototype does not match the one generated internally by PL/SQL. This can happen 
if you specify an incompatible C datatype. For example, to pass an OUT parameter 
of type REAL, you must specify float *. Specifying float, double *, or any other 
C datatype will result in a mismatch. 

In such cases, you might get a lost RPC connection to external procedure 
agent error, which means that agent extproc terminated abnormally because the 
external procedure caused a core dump. To avoid errors when declaring C 
prototype parameters, refer to the Oracle9i Data Cartridge Developer’s Guide. 

Using Package DEBUG_EXTPROC
To help you debug external procedures, PL/SQL provides the utility package 
DEBUG_EXTPROC. To install the package, run the script dbgextp.sql, which you 
can find in the PL/SQL demo directory. 

To use the package, follow the instructions in dbgextp.sql. Your Oracle account 
must have EXECUTE privileges on the package and CREATE LIBRARY privileges.

To debug external procedures: 

1. From the Windows Task Manager, in the Processes dialog, select ExtProc.exe. 

2. Right click, and select Debug. 
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3. Select OK in the message box. 

If you have built your DLL in a debug fashion with Microsoft Visual C++, then 
Visual C++ is activated. 

4. In the Visual C++ window, select Edit > Breakpoints. 

Use the breakpoint identified in dbgextp.sql in the PL/SQL demo directory.

Accessing Web Data with Intercartridge Exchange
This section discusses the following topics:

■ Configuring Intercartridge Exchange

■ Using Intercartridge Exchange

■ UTL_HTTP Exception Conditions

■ Exception Conditions and Error Messages

■ Troubleshooting

Configuring Intercartridge Exchange
You must add a parameter to the registry before using Intercartridge Exchange.

To configure Intercartridge Exchange:

1. Start the registry editor from the MS-DOS command prompt:

C:\> REGEDIT

The Registry Editor window appears.

See Also:

■ ORACLE_BASE\ORACLE_HOME\rdbms\extproc\readme.doc 
(explains how to run the sample and provides debugging advice)

■ PL/SQL User’s Guide and Reference 

■ Oracle9i Java Developer’s Guide 

■ “Calling External Procedures” in Oracle9i Application Developer’s 
Guide - Fundamentals 

■ Oracle9i Data Cartridge Developer’s Guide
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2. Add HTTP_PROXY to the registry subkey of the Oracle home directory that 
you are using. The location of this parameter is determined by how many 
Oracle home directories are on your computer:

3. Choose Add String Value from the Edit menu (Edit > New > String Value).

4. Type HTTP_PROXY in the Name field and press Enter. Data field is empty now.

5. Double click on HTTP_PROXY, Edit String dialog box will pop up.

6. Type www-proxy.your-site in the value data text box, e.g., 
www-proxy.marketing.com, where marketing.com is an example of a Web site. 
(Type the domain name of your real Web site.)

Using Intercartridge Exchange
Intercartridge Exchange enables you to use a stored package called UTL_HTTP to 
make Hypertext Transfer Protocol (HTTP) calls from PL/SQL,  SQL, and SQL*Plus 
statements.

UTL_HTTP can do both of the following:

■ Access data on the Internet

■ Call Oracle Web Application Server cartridges

UTL_HTTP contains two similar entry points, known as packaged functions, that 
turn PL/SQL and SQL statements into HTTP callouts:

■ UTL_HTTP.REQUEST

■ UTL_HTTP.REQUEST_PIECES

Both packaged functions perform the following tasks:

■ Take a string universal resource locator (URL) of a site

■ Contact that site

■ Return the data (typically HTML) obtained from that site

If you have... Add HTTP_PROXY to...

One home directory HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0

Additional 
directories

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ HOMEID 
where ID is incremented for each additional Oracle home 
directory on your computer.
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The declarations to use with both packaged functions are described in the following 
subsections.

Packaged Function UTL_HTTP.REQUEST
UTL_HTTP.REQUEST uses an URL as its argument and returns up to the first 2000 
bytes of data retrieved from that URL. 

Specify UTL_HTTP.REQUEST as follows:

FUNCTION REQUEST (URL IN VARCHAR2) RETURN VARCHAR2;
To use UTL_HTTP.REQUEST from SQL*Plus, enter:

SQL>SELECT UTL_HTTP.REQUEST(’HTTP://WWW.ORACLE.COM/’) FROM DUAL;
which returns:

UTL_HTTP.REQUEST(’HTTP://WWW.ORACLE.COM/’)                         
------------------------------------------------------

<html>
<head><title>Oracle Corporation Home Page</title>
<!--changed Jan. 16, 19
1 row selected.

Packaged Function UTL_HTTP.REQUEST_PIECES
UTL_HTTP.REQUEST_PIECES uses a URL as its argument and returns a PL/SQL 
table of 2000 bytes of data retrieved from the given URL. The final element may be 
shorter than 2000 characters. The UTL_HTTP.REQUEST_PIECES return type is a 
PL/SQL table of type UTL_HTTP.HTML_PIECES. 

UTL_HTTP.REQUEST_PIECES, which uses type UTL_HTTP.HTML_PIECES, is 
specified as:

type html_pieces is table of varchar2(2000) index by binary_integer;
function request_pieces (url in varchar2, 
   max_pieces natural default 32767)
return html_pieces;

A call to REQUEST_PIECES can look like the example below. Note the use of the 
PL/SQL table method COUNT to discover the number of pieces returned; this may 
be zero or more:

declare pieces utl_http.html_pieces;
begin 
  pieces := utl_http.request_pieces(’http://www.oracle.com/’); 
   for i in 1 .. pieces.count loop
     .... -- process each piece
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   end loop;
end;

The second argument to UTL_HTTP.REQUEST_PIECES, (MAX_PIECES) is 
optional. MAX_PIECES is the maximum number of pieces (each 2000 characters in 
length, except for the last, which may be shorter) that UTL_HTTP.REQUEST_
PIECES returns. If provided, that argument is usually a positive integer. 

For example, the following block retrieves up to 100 pieces of data (of each 2000 
bytes, except perhaps the last) from the URL. The block prints the number of pieces 
retrieved and the total length, in bytes, of the data retrieved. 

set serveroutput on
/
declare 
  x utl_http.html_pieces;
begin
  x := utl_http.request_pieces(’http://www.oracle.com/’, 100);
  dbms_output.put_line(x.count || ’ pieces were retrieved.’);
  dbms_output.put_line(’with total length ’);
  if x.count < 1 
  then dbms_output.put_line(’0’);
  else dbms_output.put_line
((2000 * (x.count - 1)) + length(x(x.count)));
  end if;
end;
/

which outputs:

Statement processed.
4 pieces were retrieved.
with total length 
7687

The elements of the PL/SQL table returned by UTL_HTTP.REQUEST_PIECES are 
successive pieces of data obtained from the HTTP request to that URL. 

UTL_HTTP Exception Conditions
This subsection describes the exceptions (errors) that can be raised by packaged 
functions UTL_HTTP.REQUEST and UTL_HTTP.REQUEST_PIECES.

UTL_HTTP.REQUEST
PRAGMA RESTRICT_REFERENCES enables the display of exceptions:

create or replace package utl_http is
function request (url in varchar2) return varchar2;
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pragma restrict_references (request, wnds, rnds, wnps, rnps);

UTL_HTTP.REQUEST_PIECES
PRAGMA RESTRICT_REFERENCES enables exceptions to be displayed:

create or replace package utl_http is
type html_pieces is table of varchar2(2000) index by binary_integer;
function request_pieces (url in varchar2, 

max_pieces natural default 32767)
return html_pieces;
pragma restrict_references (request_pieces, wnds, rnds, wnps, rnps);

Exception Conditions and Error Messages
The following table describes error messages that may appear.
     

If... Then...

Initialization of the HTTP callout subsystem fails 
for environmental reasons such as lack of 
available memory 

Exception UTL_HTTP.INIT_FAILED is raised:

init_failed exception;

The HTTP call fails due to failure of the HTTP 
daemon or because the argument to REQUEST or 
REQUEST_PIECES cannot be interpreted as a 
URL, because it is NULL or has non-HTTP syntax

Exception UTL_HTTP.REQUEST_FAILED is raised:

request_failed exception;
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No response is received from a request to the 
given URL, because the function made no contact 
with a site corresponding to that URL

A formatted HTML error message may be returned:

<HTML>

<HEAD>

<TITLE>Error Message</TITLE>

</HEAD>

<BODY>

<H1>Fatal Error 500</H1>

Can’t Access Document: 
http://home.nothing.comm.

<P>

<B>Reason:</B> Can’t locate remote host:  
home.nothing.comm.

<P>

<P><HR>

<ADDRESS><A HREF="http://www.w3.org">

CERN-HTTPD3.0A</A></ADDRESS>

</BODY>

</HTML>

Note: The first two exceptions in the preceding table, unless 
explicitly caught by an exception handler, are reported by this 
generic message:

ORA-06510: PL/SQL: unhandled user-defined 
exception

that shows them as “user-defined” exceptions, although they are 
defined in this system package.

If any other exception is raised during the processing of the HTTP 
request (for example, an out-of-memory error), then function UTL_
HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES raises that 
exception again.

If... Then...
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Troubleshooting
Do not expect UTL_HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES to succeed 
in contacting a URL unless you can contact that URL by using a browser on the 
same computer (and with the same privileges, environment variables, and so on).

If UTL_HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES fails (that is, if it raises 
an exception or returns an HTML-formatted error message, yet you believe that the 
URL argument is correct), try contacting that same URL with a browser to verify 
network availability from your computer.
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A
Error Messages

This appendix lists the error messages, causes, and corrective actions that are 
specific to the operation of Oracle9i for Windows. This appendix also includes 
database connection issues.

This appendix contains these topics:

■ Logging Error Messages

■ ORA-09275: CONNECT INTERNAL No Longer Supported

■ OSD-04000 to OSD-04599: Windows NT-Specific Oracle Messages

■ DIM-00000 to DIM-00039: ORADIM Command Syntax Errors

■ Database Connection Issues

Note: The ora.hlp file, which was shipped in previous releases, 
is no longer available. See Appendix, Oracle9i Database Error 
Messages, for information on error messages.
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Logging Error Messages 
Keep a log of error messages you receive by redirecting the messages to a file. You 
can record the contents of normal utility messages by using the LOGFILE parameter 
discussed in Oracle9i Database Utilities. You can separately record the error message 
portion by using standard Windows NT file redirection. For example, use the 
following syntax to redirect the output from the Export Utility: 

C:\> exp USERNAME/PASSWORD parfile=FILENAME >file1.log 2>file2.err

With this command line, file1.log receives the standard output from the Export 
utility, while file2.err receives the standard error messages.

ORA-09275: CONNECT INTERNAL No Longer Supported
ORA-09275

Connect internal is no longer supported
Cause:  CONNECT INTERNAL is no longer supported.

Action:  Connect to the database as CONNECT / AS SYSDBA or an existing 
user with the appropriate password.

OSD-04000 to OSD-04599: Windows NT-Specific Oracle Messages 
The error messages in this section are Oracle operating system-dependent (OSD) 
messages displayed in response to an error condition in Windows NT. Each 
message in this section triggers an Oracle9i database error message.

The error messages appear first in summary tables consisting of error numbers and 
the corresponding error message. Following the tables is a more detailed discussion 
of errors, including causes and corrective actions.

■ File I/O Errors: OSD-04000 to OSD-04099

■ Memory Errors: OSD-04100 to OSD-04199

■ Process Errors: OSD-04200 to OSD-04299

■ Loader Errors: OSD-04300 to OSD-04399

■ Semaphore Errors: OSD-04400 to OSD-04499

■ Miscellaneous Errors: OSD-04500 to OSD-04599
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File I/O Errors: OSD-04000 to OSD-04099

4000 Logical block size mismatch

4001 Invalid logical block size

4002 Unable to open file

4003 Unable to read file header block

4004 Invalid file header

4005 SetFilePointer() failure, unable to read from file

4006 ReadFile() failure, unable to read from file

4007 Truncated read

4008 WriteFile() failure, unable to write to file

4009 Truncated write

4010 <create> option specified, file already exists

4011 GetFileInformationByHandle() failure, unable to obtain file info

4012 File size mismatch

4013 Unable to read line from file

4014 Unable to close file

4015 An asynchronous I/O request returned an error

4016 Error queuing an asynchronous I/O request

4017 Unable to open the specified RAW device

4018 Unable to access the specified directory or device

4019 Unable to set file pointer

4020 Unable to set eof file marker

4021 Unable to read file

4022 Unable to write file

4023 SleepEx() failure, unable to Sleep

4024 Unable to delete file

4025 Invalid question asked

4026 Invalid parameter passed
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Memory Errors: OSD-04100 to OSD-04199

4100 malloc() failure, unable to allocate memory

4101 Invalid SGA: SGA not initialized

4102 Unable to open/create file for shared memory object

4103 Unable to attach to SGA: SGA does not exist

4104 Unable to map shared memory (SGA) into the address space

4105 Shared memory (SGA) mapped to wrong address

4106 Unable to allocate memory with VirtualAlloc

4107 Unable to deallocate memory with VirtualFree

4108 Unable to protect memory with VirtualProtect

Process Errors: OSD-04200 to OSD-04299

4200 Unable to begin another thread

4201 No pid structure supplied to spdcr()

4202 DosSetPriority() failure, unable to set process priority

4203 DosKillProcess() failure, unable to kill process

4204 Invalid pid

4205 CreateProcess() failure, unable to spawn process

4207 Invalid priority specified in CONFIG parameter ORACLE_PRIORITY

4208 OpenProcess() failure, unable to open process handle

4209 Incorrect or unknown backgound image name given to spdcr()

4210 Timeout waiting for thread semaphore

4211 Thread information not found

4212 Maximum number of ORACLE threads reached

4213 ORACLE thread unable to DuplicateHandle()

4214 ORACLE thread unable to CreateEvent()

4215 Bad function code supplied to ssthreadop

4216 Unable to find file handle for that thread
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4217 Unable to retrieve system username for current user

4218 Cannot post thread

4219 Bad thread list semaphore

4221 Target thread is currently busy

4222 Unable to get the threads context

4223 Unable to set the threads context

4224 Unable to suspend the target thread

4225 Unable to resume the target thread

Loader Errors: OSD-04300 to OSD-04399

4300 Unable to read complete record from datafile

4301 Record size too large

4302 Invalid record type, load options, or both

Semaphore Errors: OSD-04400 to OSD-04499

4400 Unable to acquire internal semaphore for process

4401 WaitForSingleObject() failure, unable to obtain semaphore

Miscellaneous Errors: OSD-04500 to OSD-04599

4500 Illegal option specified

4501 Internal buffer overflow

4502 Translations nested too deep

4503 Text contains no translatable elements

4505 stdin not responding

4506 Unable to spawn process via system()

4510 Operating system roles are not supported

4511 Unable to get date and time from the operating system

4512 Unable to translate the ’USERNAME’ config.ora variable on server

4513 ’remote_os_authent’ init.ora variable not set to true

Process Errors: OSD-04200 to OSD-04299
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File I/O Errors: OSD-04000 to OSD-04099
OSD-04000

Logical block size mismatch
Cause:  The database block size specified in the initialization parameter file 
(init.ora) does not match the block size of the actual database files.

Action:  Use matching logical block sizes.

OSD-04001
Invalid logical block size
Cause:  The logical block size is not a multiple of 512 bytes, or it is too large. 

Action:  Change the value of DB_BLOCK_SIZE in the initialization parameter 
file.

OSD-04002
Unable to open file
Cause:  The specified path or filename is invalid, or the destination device is 
full. This error can also be caused by insufficient Windows NT file handles. 

Action:  Make sure the path and file exist, and the device has free space. If this 
fails, then increase the number of Windows NT file handles. 

OSD-04003
Unable to read file header block
Cause:  The media has been damaged. 

Action:  Recover the file, if necessary, and verify that Windows NT is function-
ing correctly. 

OSD-04004
Invalid file header
Cause:  The file is damaged. 

Action:  Recover the file. 

4514 The Windows Group name is too long for internal buffer

4515 This command is not implemented at this time

Miscellaneous Errors: OSD-04500 to OSD-04599
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OSD-04005
SetFilePointer() failure, unable to read from file
Cause:  There was an unexpected return from the Windows NT system service 
SetFilePointer(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04006
ReadFile() failure, unable to read from file
Cause:  There was an unexpected return from the Windows NT system service 
ReadFile(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation.

OSD-04007
Truncated read
Cause:  The system encountered an unexpected end-of-file, which is due to 
damaged media. 

Action:  Verify that the file is not damaged. 

OSD-04008
WriteFile() failure, unable to write to file
Cause:  There was an unexpected return from the Windows NT system service 
WriteFile(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04009
Truncated write
Cause:  The destination device is full, or the media is damaged.

Action:  Verify that the device has free space and that the file is not damaged. 

OSD-04010
<create> option specified, file already exists
Cause:  The file you attempted to create already exists.

Action:  Delete the existing file or use the REUSE option in the SQL statement. 
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OSD-04011
GetFileInformationByHandle() failure, unable to obtain file info
Cause:  There was an unexpected return from the Windows NT system service 
GetFileInformationByHandle().

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04012
File size mismatch
Cause:  The file to be re-used is either too large or too small.

Action:  Specify the correct file size or delete the existing file. 

OSD-04013
Unable to read line from file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
then verify that the media is not damaged. 

OSD-04014
Unable to close file
Cause:  The media has been damaged. 

Action:  Recover the file, if necessary, and verify that Windows NT is function-
ing correctly. 

OSD-04015
Asynchronous I/O request returned an error
Cause:  There was an unexpected return from the Windows NT system service. 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04016
Error queuing an asynchronous I/O request
Cause:  There was an unexpected return from the Windows NT system service. 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 
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OSD-04017
Unable to open the specified RAW device
Cause:  An invalid path or filename was specified, or the device is full.

Action:  Make sure the file exists and the device is not full; verify that the oper-
ating system is functioning correctly.

OSD-04018
Unable to access the specified directory or device
Cause:  An invalid path name was specified. 

Action:  Make sure the directory or device exists and is accessible. 

OSD-04019
Unable to set file pointer
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
then verify that the media is not damaged. 

OSD-04020
Unable to set eof file marker
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
then verify that the media is not damaged. 

OSD-04021
Unable to read file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
then verify that the media is not damaged. 

OSD-04022
Unable to write file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
then verify that the media is not damaged. 
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OSD-04023
SleepEx() failure, unable to Sleep
Cause:  There was an unexpected return from the Windows NT system service. 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04024
Unable to delete file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
then verify that the media is not damaged. 

OSD-04025
Invalid question asked
Cause:  This is an internal error, not normally expected to occur.

Action:  Contact Oracle Support Services. 

OSD-04026
Invalid parameter passed
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

Memory Errors: OSD-04100 to OSD-04199
OSD-04100

Malloc() failure, unable to allocate memory
Cause:  The program is out of memory. 

Action:  Shut down all unnecessary processes or install more memory in the 
computer. 

OSD-04101
Invalid SGA: SGA not initialized
Cause:  The System Global Area (SGA) has been allocated but not initialized.

Action:  Wait until the STARTUP has completed before attempting to connect.
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OSD-04102
Unable to open/create file for shared memory object
Cause:  There was an unexpected return from the Windows NT system service 
CreateFile(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04103
Unable to attach to SGA: SGA does not exist
Cause:  The SGA does not exist. 

Action:  Start up an Oracle instance.

OSD-04104
Unable to map shared memory (SGA) into the address space
Cause:  There was an unexpected return from the Windows NT system service 
MapViewOfFileEx(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04105
Shared memory (SGA) mapped to wrong address
Cause:  There was an unexpected return from the Windows NT system service 
MapViewOfFileEx(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04106
Unable to allocate memory with VirtualAlloc
Cause:  The program is out of memory. 

Action:  Shut down all unnecessary processes or install more memory in the 
computer. 

OSD-04107
Unable to deallocate memory with VirtualFree
Cause:  There was an unexpected return from the Windows NT system service 
VirtualFree(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 
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OSD-04108
Unable to protect memory with VirtualProtect
Cause:  There was an unexpected return from the Windows NT system service 
VirtualProtect(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation.

Process Errors: OSD-04200 to OSD-04299
OSD-04200

Unable to begin another thread
Cause:  The program has run out of system resources. 

Action:  Shut down all unnecessary processes; install more memory in the com-
puter.

OSD-04201
No pid structure supplied to spdcr()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04202
DosSetPriority() failure, unable to set process priority
Cause:  There was an unexpected return from the Windows NT system service 
DosSetPriority(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04203
DosKillProcess() failure, unable to kill process
Cause:  There was an unexpected return from the Windows NT system service 
DosKillProcess(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04204
Invalid pid
Cause:  Process ID not recognized by system; process previously terminated.

Action:  Verify that process ID is correct and that process is active. 
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OSD-04205
CreateProcess() failure, unable to spawn process
Cause:  There was an unexpected return from the Windows NT system service 
CreateProcess().

Action:  Check the operating system error code and consult the Windows NT 
documentation.

OSD-04207
Invalid priority specified in CONFIG parameter ORACLE_PRIORITY
Cause:  The priority specified is invalid or out of range. 

Action:  Specify a valid setting for ORACLE_PRIORITY. 

OSD-04208
OpenProcess() failure, unable to open process handle
Cause:  There was an unexpected return from the Windows NT system service 
OpenProcess(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04209
Incorrect or unknown background image name given to spdcr()
Cause:  There was an unexpected background name given to spdcr(). 

Action:  Contact Oracle Support Services. 

OSD-04210
Timeout waiting for thread semaphore
Cause:  An Oracle database thread died holding the semaphore. 

Action:  Restart Oracle database instance. 

OSD-04211
Thread information not found
Cause:  An Oracle database thread died without deleting its information. 

Action:  Restart Oracle database instance. 



OSD-04000 to OSD-04599: Windows NT-Specific Oracle Messages

A-14 Oracle9i Personal Edition Getting Started

OSD-04212
Maximum number of Oracle threads reached
Cause:  The maximum number of Oracle database threads for the instance is 
reached.

Action:  Wait until some connections exit before trying again. 

OSD-04213
Oracle thread unable to DuplicateHandle()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04214
Oracle thread unable to CreateEvent()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04215
Bad function code supplied to ssthreadop
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04216
Unable to find file handle for that thread
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04217
Unable to retrieve system username for current user
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04218
Cannot post thread
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 
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OSD-04219
Bad thread list semaphore
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04221
Target thread is currently busy
Cause:  The target thread is processing an oradebug command.

Action:  Wait and resend command.

OSD-04222
Unable to get the threads context
Cause:  Check operating system error code.

Action:  Remedy operating system error.

OSD-04223
Unable to set the threads context
Cause:  Check operating system error code.

Action:  Remedy operating system error.

OSD-04224
Unable to suspend the target thread
Cause:  Check operating system error code.

Action:  Remedy operating system error.

OSD-04225
Unable to resume the target thread
Cause:  Check operating system error code.

Action:  Remedy operating system error.
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Loader Errors: OSD-04300 to OSD-04399
OSD-04300

Unable to read complete record from datafile
Cause:  The datafile ended in the middle of a record. This error occurs when 
loading files with a fixed record length. 

Action:  Verify that the datafile is of the correct length and contains complete 
records. 

OSD-04301
Record size too large
Cause:  The specified record size is too large to load. 

Action:  Reduce record size and reload the data. 

OSD-04302
Invalid record type, load options, or both
Cause:  The control file’s Windows NT file processing options string contains an 
invalid option or keyword. 

Action:  Set the Windows NT file processing options string to an acceptable 
value. 

Semaphore Errors: OSD-04400 to OSD-04499
OSD-04400

Unable to acquire internal semaphore for process
Cause:  Oracle database has exceeded the maximum number of connections. 

Action:  Delete any unused connections and try again. 

OSD-04401
WaitForSingleObject() failure, unable to obtain semaphore
Cause:  There was an unexpected return from the Windows NT system service 
WaitForSingleObject(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 
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Miscellaneous Errors: OSD-04500 to OSD-04599
OSD-04500

Illegal option specified
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services.

OSD-04501
Internal buffer overflow
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services.

OSD-04502
Translations nested too deep
Cause:  The program encountered too many intermediate translations while 
attempting to translate a configuration variable. 

Action:  Simplify the values of configuration parameters to include fewer inter-
mediate translations. 

OSD-04503
Text contains no translatable elements
Cause:  The program cannot recognize variables in the text to be translated.

Action:  Check and, if necessary, correct the text to be translated. 

OSD-04505
stdin not responding
Cause:  The system is unable to receive input from the standard input stream.

Action:  Verify that the process has access to an input device. 

OSD-04506
Unable to spawn process via system()
Cause:  The system is out of memory or the executable is invalid. 

Action:  Shut down unnecessary processes; install more memory in the com-
puter. Verify the name of the executable. 



OSD-04000 to OSD-04599: Windows NT-Specific Oracle Messages

A-18 Oracle9i Personal Edition Getting Started

OSD-04510
Operating system roles are not supported
Cause:  An attempt was made to use an operating system role. 

Action:  Only use roles that were created IDENTIFIED BY PASSWORD as 
opposed to ’IDENTIFIED EXTERNALLY’. 

OSD-04511
Unable to get date and time from the operating system
Cause:  There was an unexpected return from GetLocalTime() call. 

Action:  Verify that the system time is correct on the computer. 

OSD-04512
Unable to translate the ’USERNAME’ config.ora variable on server
Cause:  The ’USERNAME’ configuration parameter variable on the host is not 
properly set. 

Action:  Verify the ’USERNAME’ variable is set. 

OSD-04513
’remote_os_authent’ init.ora variable not set to TRUE
Cause:  For remote operating system logon to function, the ’REMOTE_OS_
AUTHENT’ parameter must be set to TRUE. 

Action:  Shut down and start up the instance with ’REMOTE_OS_AUTHENT = 
TRUE’ in the initialization parameter file. 

OSD-04514
The Windows NT Group name is too long for internal buffer
Cause:  The Windows NT Group name is too long.

Action:  Use a shorter Windows NT group name.
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DIM-00000 to DIM-00039: ORADIM Command Syntax Errors
ORADIM is a command-line utility for starting and stopping database instances that 
is only available on Oracle for Windows. It is not available on any other platform.

Oradim Errors DIM-0000 to DIM-0039

00000 ORADIM completed with no errors

00001 ORADIM: <command> [options]. Please refer to the manual.

00002 Valid commands are: -DELETE, -EDIT, -NEW, -STARTUP, and -SHUTDOWN

00003 An argument is missing for the parameter

00004 Either a SID or service name is mandatory. Please enter a valid SID or service name

00005 You have entered a SID with more than 64 characters

00006 You have entered an empty SID

00007 Missing or invalid -STARTMODE parameter. Valid -STARTMODE parameter is 
AUTO or MANUAL

00008 A valid service name is OracleService appended with a SID

00009 SID name is mandatory. Please enter a valid SID name

00010 SYSTEM\CurrentControlSet\Services\OracleService key does not exist

00011 The service does not exist

00012 You did not enter a pfile for autostart capability

00013 The service start mode could not be set in the registry

00014 Cannot open the Windows NT Service Control Manager

00015 Cannot start already-running ORACLE - shut it down first

00016 Missing or invalid -SHUTTYPE parameter. A valid -SHUTTYPE parameter is SRVC 
or INST

00017 Instance shutdown mode must be one of the following: a for abort, i for immediate 
or n for normal

00018 Failed to stop Oracle Service

00019 Create Service Error

00020 A service for this SID is already created. Please enter a different SID name. No action 
has been taken

00021 RegOpenkeyEx failed

00022 Please enter one of the following commands
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DIM-00000
ORADIM completed with no errors
Cause:  ORADIM has completed without any errors.

Action:  None.

DIM-00001
ORADIM: <command> [options]. Please refer to the manual.
Cause:  Command-line arguments could not be recognized.

Action:  Usage: ORADIM <command> [options]

00023 Create an instance by specifying the following parameters:

00024 -NEW -SID sid | -SRVC service [-INTPWD password] [-MAXUSERS number] 
[-STARTMODE a|m] [-PFILE file] [-TIMEOUT secs]

00025 Edit an instance by specifying the following parameters:

00026 -EDIT -SID sid [-NEWSID sid] [-INTPWD passwd] [-STARTMODE a|m] [-PFILE 
file] [-SHUTMODE a|i|n] [-SHUTTYPE srvc|inst]

00027 Delete instances by specifying the following:

00028 -DELETE -SID sid | -SRVC service name

00029 Startup services and instance by specifying the following parameters:

00030 -STARTUP -SID sid [-USRPWD password] [-STARTTYPE srvc|inst|srvc,inst] 
[-PFILE filename]

00031 Shutdown services and instance by specifying the following parameters:

00032 -SHUTDOWN -SID sid [-USRPWD password] [-SHUTTYPE srvc|inst|srvc,inst] 
[-SHUTMODE a | i | n]

00033 Query for help by specifying the following parameters: -? | -h | -help

00034 You have entered an invalid option for the -NEW command

00035 You have entered an invalid option for the -EDIT command

00036 You have entered an invalid option for the -DELETE command

00037 You have entered an invalid option for the -STARTUP command

00038 You have entered an invalid option for the -SHUTDOWN command

00039 Internal logic error in ORADIM

Oradim Errors DIM-0000 to DIM-0039
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Use the following commands:

To create an instance:

-NEW -SID sid | -SRVC service name [-INTPWD password][-MAXUSERS number]
[-STARTMODE auto [-PFILE filename]| manual]

To edit an instance:

-EDIT -SID sid [-NEWSID sid][-INTPWD password][-STARTMODE auto
[-PFILE filename]| manual]

To delete an instance:

-DELETE -SID sid | -SRVC service name

 To startup a service and instance:

-STARTUP -SID sid [-USRPWD password][-STARTTYPE srvc | inst | srvc,inst]
 [-PFILE filename]

To shutdown a service and instance:

-SHUTDOWN -SID sid [-USRPWD password][-SHUTTYPE srvc | inst | srvc,inst]
[-SHUTMODE a | i | n]

To query for help 

-? | -h | -help

DIM-00002
Valid commands are: -DELETE, -EDIT, -NEW, -STARTUP, and -SHUTDOWN
Cause:  You have not entered one of the referenced commands.

Action:  Use the valid commands.

DIM-00003
An argument is missing for the parameter
Cause:  You have entered an invalid argument.

Action:  Use a valid argument and start the program again.

DIM-00004 
Either a SID or service name is mandatory. Please enter a valid SID or service name
Cause:  You have not entered the SID following -SID.

Action:  Enter a valid SID of 64 characters and try again.
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DIM-00005
You have entered SID with more than 64 characters
Cause:  You have entered a SID with more than 64 characters.

Action:  Change it to 64 or fewer characters and make sure that there is no other 
service with this name.

DIM-00006
You have entered an empty SID
Cause:  Enter a SID with 64 characters and make sure that there is no service 
with this SID on your system.

Action:  Fill in the SID and rerun the program.

DIM-00007
Missing or invalid -STARTMODE parameter. Valid -STARTMODE parameter is 
AUTO or MANUAL
Cause:  You have not entered the valid start mode (AUTO or MANUAL).

Action:  Enter the valid start mode and try again.

DIM-00008
A valid service name is OracleService appended with a SID
Cause:  You have entered a service name other than OracleService(SID).

Action:  Correct the name of service and try again.

DIM-00009
SID name is mandatory. Please enter a valid SID name
Cause:  You did not enter a SID.

Action:  Enter the SID and try again.

DIM-00010
SYSTEM\CurrentControlSet\Services\OracleService key does not exist
Cause:  The referenced key is not in the registry.

Action:  Try reinstalling. If the problem persists, then contact Oracle Support 
Services.
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DIM-00011
The service does not exist
Cause:  You have tried to edit a service which does not exist, or there is an error 
trying to access the registry.

Action:   Verify service/SID name used and try again. Restart if necessary or 
contact Oracle Support Services.

DIM-00012
You did not enter a pfile for autostart capability
Cause:  You did not provide the parameter file for starting the database.   

Action:   Enter the parameter file used to start the database and retry.

DIM-00013
The service start mode could not be set in the registry
Cause:  The start mode entry in the registry for the service could not be set.

Action:  Try again later, restart, or call Oracle Support Services.

DIM-00014
Cannot open the Windows NT Service Control Manager
Cause:  The Service Control Manager could not be opened.

Action:  Restart or call Oracle Support Services.

DIM-00015
Cannot start already-running ORACLE - shut it down first
Cause:  The instance is already started; shut it down first.

Action:  Stop the database before restarting.

DIM-00016
Missing or invalid -SHUTTYPE parameter. A valid -SHUTTYPE parameter is SRVC 
or INST
Cause:  You did not enter a valid shuttype parameter (Service or Instance).

Action:  Enter parameter to shut the instance or the service and try again.
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DIM-00017
Instance shutdown mode must be one of the following: a for abort, i for immediate or n 
for normal
Cause:  You did not enter the correct mode for shutting down the database.

Action:  Enter the correct mode and try again.

DIM-00018
Failed to stop Oracle Service
Cause:  Failed to stop the Oracle Service.

Action:  Retry. If the error persists, then look at the system error or call Oracle 
Support Services.

DIM-00019
Create Service Error
Cause:  Service could not be created.

Action:  Look at the detail error.

DIM-00020
A service for this SID is already created. Please enter a different SID name. No action 
has been taken
Cause:  Service with this name already exists.

Action:  Retry with a different SID.

DIM-00021
RegOpenkeyEx failed
Cause:  This is a system error due to the service not existing or Windows error.

Action:  Retry, restart, or call Oracle Support Services.

DIM-00022
Please enter one of the following commands:

DIM-00023
Create an instance by specifying the following parameters:

DIM-00024   
-NEW -SID sid | -SRVC service [-INTPWD password] [-MAXUSERS number] 
[-STARTMODE a|m] [-PFILE file] [-TIMEOUT secs]

DIM-00025
Edit an instance by specifying the following parameters:
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DIM-00026
-EDIT -SID sid [-NEWSID sid] [-INTPWD passwd] [-STARTMODE a|m] [-PFILE 
file] [-SHUTMODE a|i|n] [-SHUTTYPE srvc|inst]

DIM00027
Delete instances by specifying the following:

DIM-00028
-DELETE -SID sid | -SRVC service name

DIM-00029
Startup services and instance by specifying the following parameters:

DIM-00030
-STARTUP -SID sid [-USRPWD password] [-STARTTYPE srvc|inst|srvc,inst] 
[-PFILE filename]

DIM-00031
Shutdown services and instance by specifying the following parameters:

DIM-00032
-SHUTDOWN -SID sid [-USRPWD password] [-SHUTTYPE srvc|inst|srvc,inst] 
[-SHUTMODE a | i | n]

DIM-00033
Query for help by specifying the following parameters: -? | -h |-help

DIM-00034
You have entered an invalid option for the -NEW command

DIM-00035
You have entered an invalid option for the -EDIT command

DIM-00036
You have entered an invalid option for the -DELETE command

DIM-00037
You have entered an invalid option for the -STARTUP command

DIM-00038
You have entered an invalid option for the -SHUTDOWN command

DIM-00039
Internal logic error in ORADIM
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Database Connection Issues
The following are common Oracle9i database connection error codes, their causes, 
and suggested remedies.

TNS-12203
TNS: unable to connect to destination
Cause:  OracleServiceSID service, OracleHome_NameTNSListener 
service, or both are not running.

Action:  Ensure that both services are started.

ORA-12560
TNS: lost contact
Cause:  OracleServiceSID service, OracleHome_NameTNSListener 
service, or both are not running. You receive this error if you attempt to use any 
of the Oracle9i Utilities, such as SQL*Plus. This error is analogous to the 
following Oracle7 error: ORA-09352: Windows 32-bit Two-Task driver 
unable to spawn new ORACLE task.

Action:  Ensure that both services are started.

ORA-28575
unable to open RPC connection to external procedure agent 
Cause:  tnsnames.ora and listener.ora files have not been correctly 
configured to use external procedures.

Action:  Reconfigure the services.

ORA-06512
at "APPLICATIONS.OSEXEC", line 0
Cause:  tnsnames.ora and listener.ora files have not been correctly 
configured to use external procedures.

Action:  Reconfigure the services.
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ORA-06512
at "APPLICATIONS.TEST", line 4 
Cause:  tnsnames.ora and listener.ora files have not been correctly 
configured to use external procedures.

Action:  Reconfigure the services.

ORA-06512
at line 2 
Cause:  tnsnames.ora and listener.ora files have not been correctly 
configured to use external procedures.

Action:  Reconfigure the services.

ORA-01031 and LCC-00161
Both codes appear at startup
Cause:  Parameter file (init.ora) or Windows services are damaged. These errors 
usually appear when the parameter file cannot be read by Oracle at database 
startup. 

Action:  Delete and recreate the SID and services. Make sure you are logged on 
as the user Administrator, or a user within the Windows Administrator’s Group 
with full administrative rights. At the MS-DOS command prompt, enter: 
oradim -delete -sid sid  where: sid is the name of your database (for 
example, orcl). Recreate the sid and services by entering: oradim -new -sid 
sid -intpwd password -startmode auto -pfile full path to 
init.ora

See Also: Oracle9i Net Services Administrator’s Guide.
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B
Getting Started with Your Documentation

Your Oracle documentation set is provided in both HTML and PDF formats on two 
CDs, both included in your CD Pack and labeled as follows: 

■ Oracle9i Online Documentation Library CD-ROM for Windows 

■ Oracle9i Online Documentation Library CD-ROM for Windows - 
Installation CD

Use the first CD-ROM to browse the library from the CD or copy files directly to a 
local system. Use the second CD-ROM to install the documentation library with the 
Oracle Universal Installer. The contents of the library are the same on both discs. 

The library includes a Web-based search tool that enables you to search for 
information about a particular product, parameter, file name, procedure, error 
message, or other area of interest. The search tool also makes it possible to construct 
a "virtual book" drawn from the complete documentation library, but consisting 
only of topics and procedures relevant to your needs. The library also includes a 
comprehensive Master Index, as well as lists of SQL and PL/SQL keywords, 
initialization parameters, catalog views, and data dictionary views.

Instructions for installing the library and viewing its contents are in three README 
files at the root level of the documentation CD-ROMs:

■ README.htm

■ README.pdf

■ README.txt

The contents of the three files are identical; only the format differs.
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The following manuals are not included on the Oracle9i Online Documentation 
Library CD-ROM for Windows:

■ Oracle9i Database installation guide for Windowsand Oracle9i Database release 
notes for Windows

To access these documents before installation, open start_here.htm in the 
\doc directory on the component CD-ROM. To access these documents after 
installation, choose Start > Programs > Oracle - HOME_NAME > Release 
Documentation or open start_here.htm in the ORACLE_BASE\ORACLE_
HOME\doc directory on your hard drive.

■ Oracle Migration Workbench documentation

The latest version can be viewed at: http://technet.oracle.com/.

■ Oracle Fail Safe and Oracle Real Application Clusters Guard documentation

These documents are on the Oracle Fail Safe and Oracle Real Application 
Clusters Guard product CD-ROM, shipping in a subsequent CD pack.
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authenticate

To verify the identity of a user, device, or other entity in a computer system, often as 
a prerequisite for allowing access to resources in a system.

authorization

Permission given to a user, application, or process to access an Oracle database or 
operating system.

backup

A representative copy of data. This copy includes important parts of your database 
such as control files, redo log files, and datafiles.

A backup is a safeguard against unexpected data loss; if you lose your original data, 
then you can use the backup to make the data available again. A backup is also a 
safeguard against an application error; if an application makes incorrect changes, 
then you can restore the backup.

connect string

See net service name.

control files

Files that record the physical structure of a database and contain the database name, 
the names and locations of associated databases and online redo log files, the time 
stamp of the database creation, the current log sequence number, and checkpoint 
information.

CORBA

See Common Object Request Broker Architecture.
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data dictionary

A set of read-only tables that provide information about a database.

DLL

See dynamic link library.

dynamic link library

An executable file that a Windows application can load when needed.

external procedures

Functions written in a third-generation language (C, for example) and callable from 
within PL/SQL or SQL as if they were PL/SQL functions or procedures.

external user 

The Windows operating system can authenticate a user, who can then access the 
Oracle database without being prompted for a password. External users are 
typically regular database users (non-database administrators) to whom you assign 
standard database roles (such as CONNECT and RESOURCE), but do not want to 
assign the SYSDBA (database administrator) or SYSOPER (database operator) 
privilege.

Globalization Support

The Oracle architecture that ensures that database utilities, error messages, sort 
order, date, time, monetary, numeric, and calendar conventions automatically adapt 
to the native language and locale.

HOMEID

Represents a unique registry subkey for each Oracle home directory in which you 
install products. A new HOMEID is created and the ID counter incremented each 
time you install products to a different Oracle home directory on one computer. 
Each HOMEID contains its own configuration parameter settings for installed 
Oracle products.

HOME_NAME

Represents the name of an Oracle home. In Oracle9i release 1 (9.0.1), all Oracle 
homes have a unique HOME_NAME.

initialization parameter file (init.ora)

An ASCII text file that contains information needed to initialize a database and 
instance.
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instance

Every running Oracle database is associated with an Oracle instance. When a 
database is started on a database server (regardless of the type of computer), Oracle 
allocates a memory area called the System Global Area and starts one or more 
Oracle processes. This combination of the System Global Area and Oracle processes 
is called an instance. The memory and processes of an instance manage the 
associated database’s data efficiently and serve the users of the database.

listener

The Oracle server process that listens for and accepts incoming connection requests 
from client applications. The listener process starts up Oracle database processes to 
handle subsequent communications with the client; then it goes back to listening for 
new connection requests.

listener.ora

A configuration file that describes one or more Transparent Network Substrate 
(TNS) listeners on a server.

Microsoft Management Console

An application that serves as a host for administrative tools called snap-ins. By 
itself, Microsoft Management Console does not provide any functionality.

migrate

To transform an installed version of an Oracle database from a major release to 
another major release. An Oracle8i for Windows database, for example, can be 
migrated to Oracle9i for Windows. Compare with upgrade.

mount

To associate a database with an instance that has been started.

multiple Oracle homes

The capability of having more than one Oracle home on a computer.

net service name

The name used by clients to identify an Oracle Net server and the specific system 
identifier. A net service name is mapped to a port number and protocol. Also 
known as a connect string, database alias, host string, or service name.

This also identifies the specific SID or database to which the connection is attaching, 
not just the Oracle Net server.
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network listener

A listener on a server that listens for connection requests for one or more databases 
on one or more protocols. See listener.

network service

In an Oracle application network, a service performs tasks for its service consumers. 
For example, a Names Server provides name resolution services for clients.

Object Request Broker

A software component that serves as the middleware between distributed objects. 
The distributed objects must comply with the Common Object Request Broker 
Architecture standard.

OCI

See Oracle Call Interface.

OFA

See Optimal Flexible Architecture.

Optimal Flexible Architecture

A set of file naming and placement guidelines for Oracle software and databases.

Oracle Call Interface

An application programming interface that enables you to manipulate data and 
schemas in an Oracle database. You compile and link an Oracle Call Interface 
application in the same way that you compile and link a non-database application. 
There is no need for a separate preprocessing or precompilation step.

Oracle Net Naming

Oracle Net Naming with Active Directory stores and resolves names through Active 
Directory. 

Oracle Protocol Support

A product that maps the functions of a given network protocol into Oracle 
Transparent Network Substrate (TNS) architecture. This process translates TNS 
function calls into requests to the underlying network protocol. This allows TNS to 
act as an interface among all protocols. 
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Oracle services

Windows services that are associated with particular Oracle components.

ORACLE_BASE

ORACLE_BASE is the root of the Oracle directory tree. If you install an 
OFA-compliant database using Oracle Universal Installer defaults, then ORACLE_
BASE is X:\oracle where X is any hard drive (for example, C:\oracle).

ORACLE_HOME

Corresponds to the environment in which Oracle products run. This environment 
includes the location of installed product files, the PATH variable pointing to the  
binary files of installed products, registry entries, net service names, and program 
groups.

If you install an OFA-compliant database, using Oracle Universal Installer defaults, 
then Oracle home (known as \ORACLE_HOME in this manual) is located beneath 
X:\ORACLE_BASE. It contains subdirectories for Oracle software executables and 
network files.

ORB

See Object Request Broker

PL/SQL

Oracle Corporation’s procedural language extension to SQL.

PL/SQL enables you to mix SQL statements with procedural constructs. You can 
define and run PL/SQL program units such as procedures, functions, and packages.

precompiler

A programming tool that enables you to embed SQL statements in a high-level 
source program.

privilege

A right to run a particular type of SQL statement or to access another user’s object.

process

A mechanism in an operating system that can run an executable. (Some operating 
systems use the terms job or task.) A process normally has its own private memory 
area in which it runs. On Windows a process is created when an application runs 
(such as Oracle or Microsoft Word). In addition to an executable program, all 
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processes consist of at least one thread. The Oracle master process contains 
hundreds of threads. 

recovery

To restore a physical backup is to reconstruct it and make it available to the Oracle 
server. To recover a restored backup is to update it using redo records (that is, 
records of changes made to the database after the backup was taken). Recovering a 
backup involves two distinct operations: rolling back all changes made in 
uncommitted transactions to their original state, and rolling forward  to a more 
current time by applying redo data.

redo log buffer

A circular buffer in the System Global Area that contains information about 
changes made to the database.

redo log files

Files that contain a record of all changes made to data in the database buffer cache. 
If an instance failure occurs, then the redo log files are used to recover the modified 
data that was in memory.

registry

A Windows repository that stores configuration information for a computer.

remote database

A database on a computer other than the local database.

replication

The process of copying and maintaining database objects in multiple databases that 
make up a distributed database system.

roles

Named groups of related privileges. You can grant roles to users or other roles.

schemas

Named collections of objects, such as tables, views, clusters, procedures, and 
packages, associated with particular users.
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services

Executable processes installed in the Windows registry and administered by 
Windows. Once services are created and started, they can run even when no user is 
logged on to the computer.

service name

See net service name.

SGA

See System Global Area.

SID

See system identifier.

snap-ins

Administrative tools that run within Microsoft Management Console.

snapshot

(1) Information stored in rollback segments to provide transaction recovery and 
read consistency. Rollback segment information can be used to recreate a snapshot 
of a row before an update.

(2) A point-in-time copy of a master table located on a remote site. Read-only 
snapshots can be queried, but not updated. Updateable snapshots can be queried 
and updated. They are periodically refreshed to reflect changes made to the master 
table, and at the snapshot site.

starter database

A preconfigured, ready-to-use database that requires minimal user input to create.

SYSDBA

A special database administration role that contains all system privileges with the 
ADMIN OPTION, and the SYSOPER system privilege. SYSDBA also permits 
CREATE DATABASE actions and time-based recovery.

SYSOPER

A special database administration role that permits a database administrator to 
perform STARTUP, SHUTDOWN, ALTER DATABASE OPEN/MOUNT, ALTER 
DATABASE BACKUP, ARCHIVE LOG, and RECOVER, and includes the 
RESTRICTED SESSION privilege.
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System Global Area

A group of shared memory structures that contain data and control information for 
an Oracle instance.

system identifier

A unique name for an Oracle instance. To switch between Oracle databases, users 
must specify the desired system identifier. The system identifier is included in the 
CONNECT DATA parts of the connect descriptors in a tnsnames.ora file, and in the 
definition of the network listener in a tnsnames.ora file.

SYSTEM

One of two standard database administrator usernames automatically created with 
each database. (The other username is SYS.). The SYSTEM username is the 
preferred username for database administrators to use for database maintenance.

tablespace

A database is divided into one or more logical storage units called tablespaces. 
Tablespaces are divided into logical units of storage called segments, which are 
further divided into extents.

thread

An individual path of execution within a process. Threads are objects within a 
process that run program instructions. Threads allow concurrent operations within 
a process so that a process can run different parts of its program simultaneously on 
different processors. A thread is the most fundamental component that can be 
scheduled on Windows.

tnsnames.ora

A file that contains connect descriptors mapped to net service names. The file can be 
maintained centrally or locally, for use by all or individual clients.

trace file

Each server and background process can write to an associated trace file. When a 
process detects an internal error, it dumps information about the error to its trace 
file. Some of the information written to a trace file is intended for the database 
administrator, while other information is intended for Oracle Support Services. 
Trace file information is also used to tune applications and instances.
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upgrade

To transform an installed version of an Oracle database major release into another 
major release of the same version. Compare with migrate.

username

A name that can connect to and access objects in a database.

view

A selective presentation of the structure and data of one or more tables. Views can 
also be based on other views.
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DLLs

differences on Windows 98, NT and UNIX, 2-5
external procedures, 8-8



Index-2

E
environment variables

ORACLE_HOME, 5-10
TNS_ADMIN, 5-12

error messages
DIM-00000 to DIM-00039, A-19
Intercartridge Exchange, 8-16
logging, A-2
ORA-12560, A-26
OSD-04000 to OSD-04099, A-6
OSD-04100 to OSD-04199, A-10
OSD-04200 to OSD-04299, A-12
OSD-04300 to OSD-04399, A-16
OSD-04400 to OSD-04499, A-16
OSD-04500 to OSD-04599, A-17
OSD-09275, A-2

Event Viewer
operating system compatibility, 4-4

exception conditions, Intercartridge 
Exchange, 8-15

executable images
modifying, 3-4

EXECUTE privileges, on a PL/SQL library, 8-9
Export Utility

operating system compatibility, 4-3
preferred tools, 4-5
redirecting output, A-2
starting, 4-11

Export Wizard
preferred tools, 4-5

EXTERNAL clause, 8-9
external procedures

building a DLL, 8-8
creating a PL/SQL library, 8-9
debugging, 8-11
EXTERNAL clause, 8-9
granting EXECUTE privileges, 8-9
registering with Oracle database, 8-9
using EXTPROC, 8-7
writing, 8-7

EXTPROC
example, 8-7
responsibilities, 8-7

F
file sizes

on Windows 98, NT and UNIX, 2-4
files

oracle.key, 5-10

H
HOME_COUNTER parameter, 7-7

I
ICX. See Intercartridge Exchange
Import Utility

operating system compatibility, 4-3
preferred tools, 4-5

Import Wizard
preferred tools, 4-5

initialization parameters
on Windows 98, NT and UNIX, 2-4

INST_LOC parameter, 7-6
install accounts

on Windows 98, NT and UNIX, 2-5
installation

differences on Windows 98, NT and UNIX, 2-6
instance

Oracle, 3-2
Intercartridge Exchange

accessing Web data, 8-12
configuring, 8-12
error messages, 8-16
exception conditions, 8-15
packaged functions, 8-13
stored packages, 8-13
troubleshooting, 8-18
using, 8-13

internet applications
developing, 8-5

INTYPE File Assistant
starting, 4-9

K
keys

defined, 7-2
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L
LAST_HOME parameter, 7-7
Load Wizard

preferred tools, 4-5
logging error messages, A-2

M
memory resources

on Windows 98, NT and UNIX, 2-5
Microsoft ODBC Administration

starting, 4-9
Migration Utility

operating system compatibility, 4-3
preferred tools, 4-5
starting, 4-11

MSHELP_TOOLS parameter, 7-5
multiple Oracle homes

benefits, 5-3
environment, 5-5
functionality in different releases, 5-3
introduction, 5-2
on Windows 98, NT and UNIX, 2-7
overview, 5-2
program groups, 5-6
registry entries, 5-6
system identifier, 5-6
use of one listener for spawning, 5-5

N
NAME parameter, 7-7
Net Configuration Assistant

starting, 4-9, 4-10
Net Manager

starting, 4-9
NLS_LANG parameter, 7-5

O
Object Type Translator

operating system compatibility, 4-2
OCOPY

operating system compatibility, 4-3
preferred tools, 4-5

starting, 4-11
OO4O parameter, 7-6
OPERFCFG

operating system compatibility, 4-3
Optimal Flexible Architecture

benefits, 5-13
characteristics of a database, 5-14
default OFA database, 5-19
differences since previous releases, 5-15
introduction, 5-2
nondefault OFA database 1, 5-20
nondefault OFA database 2, 5-21
overview, 5-12

ORA_CWD parameter, 7-5
ORA_SID_PFILE parameter, 7-5
Oracle Advanced Security

operating system compatibility, 4-3
Oracle Data Migration Assistant

operating system compatibility, 4-3
preferred tools, 4-5
starting, 4-9, 4-10

Oracle Database Configuration Assistant
operating system compatibility, 4-3
starting, 4-9, 4-10

Oracle home
new-style, defined, 5-12

Oracle Home Selector
changing PATH value, 5-8

Oracle Migration Workbench
operating system compatibility, 4-3

Oracle Net
configuring for external procedures, 8-7

Oracle Net Configuration Assistant
operating system compatibility, 4-3

Oracle Net Manager
operating system compatibility, 4-3

Oracle Performance Monitor
operating system compatibility, 4-3

Oracle Portal
operating system compatibility, 4-2

Oracle Services for Microsoft Transaction Server
operating system compatibility, 4-2

ORACLE_BASE
explained, 5-16

ORACLE_BASE parameter, 7-5
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ORACLE_GROUP_NAME parameter, 7-5
ORACLE_HOME

directory structure, 5-17
environment variable, 5-10, 5-11
specifying, 5-19

ORACLE_HOME parameter, 7-5
ORACLE_HOME_KEY parameter, 7-5
ORACLE_HOME_NAME parameter, 7-5
ORACLE_SID parameter, 7-6
oracle.key file, 5-10, 5-11
ORADATA directory, explained, 5-18
ORADIM

command syntax errors, A-19
operating system compatibility, 4-3
starting, 4-11

ORAPWD
operating system compatibility, 4-3
preferred tools, 4-5
starting, 4-11

P
packaged functions

Intercartridge Exchange, 8-13
UTL_HTTP.REQUEST, 8-14
UTL_HTTP.REQUEST_PIECES, 8-14

parameters
TNS_ADMIN, 5-12

PARFILE, using, A-2
Password Utility

operating system compatibility, 4-3
passwords

changing, 6-2, 6-3
for default accounts, 6-4

PATH parameter, 7-7
PATH, changing the value of, 5-7
performance utilities

on Windows 98, NT and UNIX, 2-8
PRAGMA RESTRICT_REFERENCES, with 

Intercartridge Exchange, 8-15
Pro*C/C++

operating system compatibility, 4-2
Pro*COBOL

operating system compatibility, 4-2
processes

on Windows 98, NT and UNIX, 2-3
program groups

multiple Oracle homes, 5-6

R
raw partition

on Windows 98, NT and UNIX, 2-10
RDBMS_ARCHIVE parameter, 7-6
RDBMS_CONTROL parameter, 7-6
Recovery Manager

operating system compatibility, 4-3
preferred tools, 4-5

Recovery Wizard
preferred tools, 4-5

registering an external procedure, 8-9
registry

adding parameters, 7-9
and multiple Oracle homes, 5-6
configuration parameters, defined, 7-2
DEFAULT_HOME, 7-7
editor, 7-2
HOME_COUNTER, 7-7
INST_LOC, 7-6
keys, defined, 7-2
LAST_HOME, 7-7
MSHELP_TOOLS, 7-5
NAME, 7-7
NLS_LANG, 7-5
OO4O, 7-6
ORA_CWD, 7-5
ORA_SID_PFILE, 7-5
ORACLE_BASE, 7-5
ORACLE_GROUP_NAME, 7-5
ORACLE_HOME, 7-5
ORACLE_HOME_KEY, 7-5
ORACLE_HOME_NAME, 7-5
ORACLE_SID, 7-6
PATH, 7-7
RDBMS_ARCHIVE, 7-6
RDBMS_CONTROL, 7-6
starting, 4-12

roles
of default accounts, 6-4
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S
Server Manager

replacement, 4-2
services

on Windows 98, NT and daemons on UNIX, 2-2
SQL*Loader

control file conventions, 4-13
direct path option, 4-13
operating system compatibility, 4-3
preferred tools, 4-5
starting, 4-12

SQL*Plus
operating system compatibility, 4-2, 4-3
starting, 4-9, 4-12

stored packages, Intercartridge Exchange, 8-13
system identifier

multiple Oracle homes, 5-6

T
threads

and multiple Oracle instances, 3-2
and ORASTACK, 3-4
defined, 3-2
on Windows 98, NT and UNIX, 2-3
optional and required, 3-3
process errors, A-4

TKPROF
operating system compatibility, 4-3
starting, 4-12

tools, starting
DBVERIFY, 4-11
Export Utility, 4-11
INTYPE File Assistant, 4-9
Microsoft ODBC Administration, 4-9
Migration Utility, 4-11
Net Configuration Assistant, 4-9
Net Manager, 4-9
OCOPY, 4-11
Oracle Data Migration Assistant, 4-9
Oracle Database Configuration Assistant, 4-9
Recovery Manager, 4-11
SQL*Plus, 4-9
TKPROF, 4-12

troubleshooting
Intercartridge Exchange, 8-18
ORA-12560 error, A-26
ORA-28575 error, A-26
TNS-12203 error, A-26

U
UNIX

differences between UNIX and Windows 98, 
NT, 2-2

usernames
changing, 6-3
of administrative accounts, 6-4

UTL_HTTP.REQUEST, Intercartridge 
Exchange, 8-14

UTL_HTTP.REQUEST_PIECES, Intercartridge 
Exchange, 8-14

W
Web data, Intercartridge Exchange, 8-12
Windows

tools operating system compatibility, 4-4



Index-6


	Contents
	Send Us Your Comments
	Preface
	1 Introduction
	Document Plan
	Task Mapping

	2 Oracle9i Differences between Windows 98, Windows NT, and UNIX
	3 Oracle9i Architecture on Windows
	Oracle9i on Windows Architecture
	Thread-Based Architecture

	Other Sources of Information

	4 Database Tools Overview
	Choosing a Database Tool
	Database Tools and Operating System Compatibility
	Preferred Database Tools

	Starting Database Tools
	Starting Database Tools in Multiple Oracle Homes
	Starting Database Tools from the Start Menu
	Starting Database Tools
	Starting Database Tools from the Command Line
	Starting Windows 98 Tools

	Using SQL*Loader
	Windows 98 Processing Options
	Direct Path Option
	Control File Conventions

	Using Windows Tools
	Registry


	5 Multiple Oracle Homes and Optimal Flexible Architecture
	Introduction to Multiple Oracle Homes and OFA
	Multiple Oracle Homes Overview
	What Is an Oracle Home?
	Benefit of Using Multiple Oracle Homes
	Multiple Oracle Home Functionality in Different Releases
	One-Listener Support of Multiple Oracle Homes
	Multiple Oracle Home Environments

	Changing the Value of PATH
	Using Oracle Home Selector
	At the System Level
	At the MS-DOS command prompt

	Exiting Oracle Universal Installer After Entering Name and PATH
	Setting Variables in the Environment or the Registry
	ORACLE_HOME
	TNS_ADMIN

	Optimal Flexible Architecture Overview
	Benefits of an OFA-Compliant Database
	Characteristics of an OFA-Compliant Database

	Differences Between Directory Trees by Release
	Top-Level Oracle Directory
	Database Filenames
	Database Filename Extensions

	OFA Directory Naming Conventions
	ORACLE_BASE Directory
	ORACLE_HOME Directory
	ADMIN Directory
	ORADATA Directory
	DB_NAME Directory

	OFA and Multiple Oracle Home Configurations
	Specifying an ORACLE_HOME Directory
	Installing a Default OFA Database: Example
	Installing a Nondefault OFA Database: Example 1
	Installing a Nondefault OFA Database: Example 2


	6 Oracle9i Default Accounts and Passwords
	Overview
	Unlocking and Changing Passwords
	Granting Limited SYS Database Role Privileges
	Reviewing Accounts and Passwords

	7 Configuration Parameters and the Registry
	About Configuration Parameters
	Registry Overview
	Registry Parameters
	HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID
	HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE
	HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ALL_HOMES

	Modifying a Registry Value with REGEDIT
	Adding a Registry Parameter with REGEDIT
	Adding or Modifying Initialization File Parameters and Registry Parameters with Oracle9i Navigato...
	Introducing Database Parameter Configuration Assistant
	Introduction to Manipulating Database Initialization Parameters
	Introduction to Manipulating Oracle9i Configuration Parameters


	8 Developing Applications for Windows
	Finding Information on Application Development for Windows 98
	Java Enhancements
	XML Support
	Application Wizards
	Oracle COM/COM+ Integration Feature
	OLE DB

	Developing Windows Applications
	Building External Procedures
	External Procedures Overview
	Task 1: Installing and Configuring
	Task 2: Writing an External Procedure
	Task 3: Building a DLL
	Task 4: Registering an External Procedure
	Task 5: Executing an External Procedure

	Debugging External Procedures
	Using Package DEBUG_EXTPROC

	Accessing Web Data with Intercartridge Exchange
	Configuring Intercartridge Exchange
	Using Intercartridge Exchange


	A Error Messages
	Logging Error Messages
	ORA-09275: CONNECT INTERNAL No Longer Supported
	OSD-04000 to OSD-04599: Windows NT-Specific Oracle Messages
	File I/O Errors: OSD-04000 to OSD-04099
	Memory Errors: OSD-04100 to OSD-04199
	Process Errors: OSD-04200 to OSD-04299
	Loader Errors: OSD-04300 to OSD-04399
	Semaphore Errors: OSD-04400 to OSD-04499
	Miscellaneous Errors: OSD-04500 to OSD-04599

	DIM-00000 to DIM-00039: ORADIM Command Syntax Errors
	Database Connection Issues

	B Getting Started with Your Documentation
	Glossary
	Index

